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Installation & Authorization procedure
Together with the download link from Share-it you have received attached to the product
delivery email a keyfile called 'Icarus.t2k'.
This file contains your personal serial number & your name and is used to unlock the full
version.
Automatic Installation (recommended) for PC & Mac
1. Close your host (Logic, Live, Cubase, etc.)
2. Install the full version of the plugin.
3. Open your host program
4. Do a plugin rescan in the host if it does not list Icarus. Detailed instructions on how to
perform a rescan can be found in your host's manual
5. Open Icarus
6. Click on the “I bought the full version.....” box on the bottom right part of the screen.
7. Click on the “Click here to activate now...”
8. Browse-to & select your keyfile 'Icarus.t2k' to activate the full version
9. Restart the plugin. Note that some host programs may require a complete restart

Click on the “I bought the full version...”screen to browse-to & select your Icarus.t2k keyfile
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Manual installation for PC
1. Close your host (Logic, Live, Cubase, etc.)
2. Install the full version of the plugin.
3. Copy 'Icarus.t2k' to the VST directory. Steinberg hosts often use C:\Program
files\Steinberg\VSTplugins as the default plugin path. You can also take a look at your
host's folder configuration. Note that the 'Icarus .t2k' keyfile should be inside the same
folder that the Icarus.dll is in.
4. Open your host program.
5. Do a plugin rescan in the host if it does not list Icarus. Detailed instructions on how to
perform a rescan are found in your host's manual.
6. Open Icarus. Now the normal user interface appears. If this is not the case, close your
host and go back to step 3, as most likely you did not copy the keyfile to the right
place.

Manual installation for Mac
1. Close your host (Logic, Digital Performer, Live, Cubase, etc.)
2. Install the full version of the plugin.
3. Copy 'Icarus.t2k' to 'Library/Audio/Plug-ins'. The correct path for the file is:
'/Library/Audio/Plug-ins/Icarus.t2k'.
4. Open the host.
5. Do a plugin rescan in the host if it does not list Icarus. Detailed instructions on how to
perform a rescan can be found in your host's manual
6. Open Icarus. Now the normal user interface appears. If this is not the case, close your
host and go back to step 3, as most likely you did not copy the keyfile to the right
place.
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Welcome to Icarus
Icarus is a wavetable synthesizer, equipped with a high-end quality sound engine. An engine
that is flexible as well as offer an enormous number of features, yet remains easy and intuitive
to work with.
We call Icarus a '3D wavetable synthesizer', because we expanded the wavetable concept,
allowing you to cross-blend waveforms, with an additional dimension for morphing.
Next to its wavetable capabilities it also offers resynthesis, true stereo architecture, hypersaw
oscillators, a wavetable editor, modular effects, a vocoder, dual filter section, programmable
arpeggiator and a comfortable patch browser. Which is why Icarus is one of the most
powerful synthesizers on the market.
Resynthesis
Working with conventional resynthesis methods you need a deep knowledge of sample
editing to achieve good results, doing consuming pre-processing with a sample editor as well
as require precisely tuned samples.
We have taken care of these problems and developed completely new algorithms. Icarus'
resynthesis works on nearly any kind of audio material, is very easy to use and provides you
with high quality results.
Simply click on the button - select a wav file - wait for some seconds and Icarus will
automatically create a patch, which sounds very similar to the original sound. Optionally you
can use the morph modes or the wavetable editor to further shape your sound.
Effects
Tone2 Icarus comes with a flexible effects section. Three Modular slots, each with 53 different
effect types. You can create your own custom effects, which can be saved & loaded
separately. The flexible routing allows you to route single oscillators to different effects.
The innovative ducking mode can change the dry/wet mix of delays and reverbs dynamically,
resulting in a more transparent mix. The additional feedback section allows you to route the
output back to the input, this way you can create completely new effects, like a delayedphaser or a feedbacked vibrato. An additional EQ and a limiter is provided to make your
sound sit right in the mix. We developed innovative microtuning algorithms, which make
chords sound more fat, harmonic and warm.
Oscillators
Icarus is a '3D wavetable synthesizer', we expanded the wavetable concept, allowing you to
cross-blend waveforms, with an additional dimension for morphing. You can use any of the 54
different 'morphmodes' to further shape the sound of your wavetables: Waveshaping, timestretching, pitch- shifting, granulizing, stacking, PWM, formant shifting, BPM syncing, phase
distortion, reversing, ringmodulation, sync, rearranging, FM, spectral editing, looping,
denoising, mixing,... - literally anything is possible.
Icarus offers three oscillator blocks with stereo architecture. Each oscillator block itself again
can contain up to 10 detuned hypersaw oscillators.
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We've expanded the popular hypersaw concept with a stereo architecture, precise phase
control, punch and the ability to make single oscillators play chords.
37 different modes are available, including, hypersaw, supersaw, stereo hypersaw, unison,
stacking, chords and flanging.
The hypersaw modes can be combined with any kind of wavetable and morph mode.
Filters
Tone2 Icarus comes with a powerful, modular filter section. Two blocks, each equipped with
true stereo architecture and a multi-mode filter.
Over 60 different sounding filter types are available: Vocal, fractal, analog, digital, resonator,
EQ, ring modulation, amplitude modulation, FM, phaser, comb, physical modeling, multimode, resampling, … All filters offer the highest possible sound quality, many of them
exclusive to Icarus.
The animated display offers an immediate visual overview of the filter's frequency response,
making it easy to understand and tweak the filters.
Flexible routing allows you to route every oscillator individually to filter1, filter2 or bypass.
Additionally, two distortion sections, each with 9 different modes allow you to further shape
the sound.
Vocoder
Icarus contains a high-end quality vocoder module with 1024 bands. It's very easy to use:
Simply click on 'Vocoder' and select a wav file containing speech, Icarus will analyze this file
and automatically create a patch.
Optionally, apply one of the morph modes to further shape your sound. Playing the sound
forwards, backwards, formant shifting, time-stretching and looping is also possible.
The vocoder sound is automatically stored within your patches and songs, you won't have to
worry about managing these additional files on your hard disc.
Arpeggiator
Almost a synth by itself, the arpeggiator section holds the key to all of your arpeggio needs. It
provides you with the tools to set up & use your own arpeggios, in a way that is both powerful
and easy.
Working with the arpeggiator is very simple, just lay down your notes inside the note
sequencer and select the play direction. The arpeggiator also supports advanced features
such as chords, glides, swing & shuffle, split, matrix integration, as well as giving you very
precise control over note-sorting, play direction and velocity.
Don’t feel like programming your own patterns? Use one of the built-in patterns or load one of
the many external pattern presets to use as a starting point.
Working with an arpeggiator should be fun and inspiring, the arpeggiator in Icarus is as fun
and inspiring as it is powerful, flexible and easy to use.
Sounds
With a powerful and sonically versatile approach to audio production, Icarus provides you with
truly outstanding new sounds.
7

Icarus comes with an astounding sound collection of over 1000 production-ready sounds
designed by professional sound designers. A comfortable patch browser is provided to give
you an instant overview of the available categories and sounds, together with an on-screen
keyboard to audition them from within the patch browser. Picking the sound you want is as
easy as it can be. Icarus is ready for any type of music you play!
Interface
The user-friendly interface makes tweaking accessible to everyone, regardless of skill level or
experience. All controls provide you with visual feedback, making it easy to understand and
tweak the synthesizer. The animated displays and tool tips instantly visualize what the filters,
the LFOs, the envelopes and the oscillators are doing.
Over 40 different color schemes are available for the interface. With several instances of the
synthesizer loaded at the same time, it's even possible to show single instances with different
colors. Helping you to keep an overview when working on a complex project with many
instances of Icarus.
Wavetable editor
You can use the built-in wavetable editor to create your own wavetables or to edit one of the
many stock wavetables that ship with Icarus.
Using only a mouseclick, a smart wavetable generator allows you to generate an infinite
number of completely new and musically useful wavetables. Or even use the mouse to paint
your own waveforms.
The spectral editor turns Icarus into an additive synthesizer, giving you detailed control over
the partials and phase.
It is possible to drag & drop waveforms or wavetables into the editor or oscillators.
The wavetables are stored within your patches and songs, so you don't have to worry about
managing any additional files on your hard disc.
Many common wavetable & waveform formats are supported and it is possible to import and
export wavetables from-and-to other synthesizers.
A large, professional set of tools are available, giving you a comfortable and efficient way to
edit waveforms and wavetables. This includes basic features like, cutting, mixing and filtering,
as well as advanced tools like, denoising, enhancing, resynthesis, vocoder, spectral
modification and phase manipulation.
Icarus' flexible, compact and open file format allows sound designers & artists to easily create
their own soundsets, waveforms and wavetables.
Modulation
Modulation is where the true power of a synthesizer emerges. By using the modulation matrix,
Icarus allows you to connect dozens of modulation sources to all-important sound
parameters.
Want to use an LFO to wobble your filter? Simply set the proper assignments inside of the
modulation matrix and you're on your way.
Modulate almost any parameter well up into the audio-rate speed, from internal modulation
sources like the LFOs, to a wide variety of MIDI messages. We've also included midi-learn, so
assigning CC's is as simple as a right-click and a knob-turn.
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Modulation can be as simple or complex as you want it to be. Icarus’ modulation system is
there to provide whichever modulation routing you require to create your perfect sound.
CPU
CPU load is always an important factor to consider, especially in light of today's complicated
multi-track projects. We made sure that Icarus is as easy on your CPU as possible. Icarus
offers a rich, deep sound, the very best sound quality, AND low CPU usage. What is the
advantage of good sound quality if it consistently brings your system to a halt with a mere
single instance of the synth?
The low CPU requirement ensures that you can easily use multiple instances of the synth
without overloading your project and without the need to render tracks right in the middle of a
creative session.
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The Icarus User Interface

The Icarus user interface is designed to make patch designing and editing intuitive and fun.
All the sound editing parameters are kept on a single page so that you can see the signal flow
without getting lost in multiple tabs and pages.
The UI (User Interface) is larger than most software synthesizers but once your patch is built
you can switch off the EDITOR view (click the EDITOR button above the Patch Browser
section) leaving just the Rack GUI which saves considerable screen real-estate.
Parameter changes are always displayed in the bottom section of the PATCH BROWSER
display, values are displayed as soon as the mouse pointer is hovered over one of Icarus'
controls.
The Rack View shows just the patch / file management and basic sound editing functions of
Icarus – if you’re just loading a patch, or browsing for inspiration, this is all you’ll ever need.
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Top menu

•

File button – This menu offers patch Load and Save, as well as Initialization &
Optimize patch options. The menu options are:
◦ Load patch – Loads a patch from disk
◦ Save patch as – Opens a file dialog to save the current patch to file
◦ Quick save patch – The preset file inside the current category (within
icarus_sounds) is overwritten.
◦ Download sounds – This takes you to Tone2's website where you can buy
additional sound banks to be used with Icarus.
◦ Init patch – This option initializes all of the synth's settings to their default values.
◦ Random patch – This option randomizes all synth settings.
◦ Optimize patch – This removes unused wavetables and modulation matrix slots to
enhance performance and save hard disk space.
◦ Reset Midi-learn – Select this option to remove / reset all previously learned midi
CC assignments.

•

Editor button – This button switches Icarus' interface to either Rack or Editor mode.
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Patch Display

There are four arrow shaped buttons inside the PATCH BROWSER display window, these
buttons allow you to navigate / switch to different patches or patch categories.
•

Arrow Up (next to the Patch name) – loads the previous patch in the current patch
category

•

Arrow Down (next tot the Patch name) – loads the next patch in the current category

•

Arrow Up (next to the Category name) – loads the previous patch in the current patch
category

•

Arrow Down (next tot the Category name) – loads the next patch in the current
category
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Sound Section

•

Browser button

Icarus comes with a comfortable patch browser that allows you to see all patches and patch
categories in one window. This gives you an quick overview of all patches available,
together with an on-screen keyboard to play your sounds using a mouse.
The Patch Browser is split up into 3 sections:

◦ Type: Displays the current patch category / type of patch.
◦ Patch: Displays the list of patches available in the currently selected category.
◦ Info: The Info window displays all information on the selected patch, e.g. used
playmode, synthesis type, etc..
To exit the Patch Browser, click on the Exit button (bottom left of the screen)
Patch Organization
Icarus banks and presets can be organized with your standard file browser. In the
'Tone2/Icarus_sounds' folder you'll find the different banks as seen in Icarus' Both
the folders and the .fxp patch files contained inside can organized / renamed and the
changes will be displayed the next time you start Icarus.
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•

Resynthesis button

Icarus comes with a powerful resynthesis feature. Resynthesis means that a sound of your
choice is analyzed and reassembled within the synthesizer. Unlike conventional sampling,
where the sample is just a simple copy of the original sound, the resynthesized sound is a
completely new, but similar sounding patch, which is rebuilt from the scratch.
With resynthesis there are many things possible, which are impossible with conventional
samples or which can not properly done with them:
- Variable Pitch shifting
- Variable time stretching
- BPM syncing
- Time freezing
- Forward and backward playback with variable speed
- Formant shifting (eliminates the 'Mickey Mouse' effect on vocals)
- Morphing
There are many synthesizers out there, which are advertized to be capable of 'resynthesis'.
However the results that these products give are mostly poor: They produce heavy rumble
and artifacts when a sample isn't tuned exactly, they fail with chords, they fail with voices, they
fail with many natural sounds, they fail with pitch slides and they are difficult to use. We have
taken care of these problems.
How to resynthesize a sample
Click on RESYNTHESIS and select 'Easy create patch: Resynthesis'. Select a short wav
sample of your choice...

Tips for the best results:
- Use single sounds, avoid melodies.
- Try to avoid samples with other instruments or percussion in the background.
- Recordings from monophonic sounds give better results than chords.
- The sound quality of the processed wav file should high.
- Use 16 bit mono files with less than 2 seconds length.
- If you use very large files the processing time will be also very long.
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...wait for some seconds. The synth now created a new patch. OSC1 contains a wavetable
which contains waveforms that have been resynthesized from your wav file. Lfo1 now controls
the WAVE position of this wavetable.
When you change the SPEED knob of Lfo1 you can change the playback speed of the sound.
When you change the octave with the OCT knob, you can change the pitch of the sound.
Please note that a change of the SPEED does not affect the pitch, like with conventional
samples. You can pitchshift and timestrech a resynthesized samples without quality loss. It's
even possible to BPM sync loops or to play samples forward and backward by changing the
Lfo1 SHAPE.
TIP: Apply a Morph Mode to change the sound.
TIP: Combine the Vocoder and Formant Morph Modes for formant shifting on vocals.
TIP: You can resynthesize wavetables without automatically creating a new patch in the TOOL

menu of the oscillators.
The following resynthesis options are available:
◦ Easy create patch: Resynthesis - Is the default mode which gives the best results
with most sounds. You should use this one.
◦ Easy create patch: Additive Resynthesis - Works like the previous one, but
removes all phase information and detuning from the sample. As a result you get
the cold sound known from additive synthesizers.
TIP: Later you can use the spectral editor to change the partials and to turn Icarus

into a complete additive synthesizer!
◦ Easy create patch: Resynthesis for noisy sounds - Works like the normal
resynthesis, but sometimes gives better results with very noisy sounds like flutes.
◦ Easy create patch: Granulator - Creates a patch which uses granular synthesis.
In granular synthesis a sample is divided into small 'grains' with a window function.
Use the OCT knob to control the density of the grains. Use the MORPH knob the
change the pitch of the grains. Change the Lfo1 SHAPE to a triangle for a forward
and backward playback. Change Lfo1 SPEED for a faster or slower playback of the
sound. When you set SPEED to 0 you can timefreeze the sample. You can use the
WAVE knob to move within the sound.
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◦ Easy create patch: Time stretch large / medium / small blocks - Loads a
sample and timestreches or pitchshifts it. 'Medium blocks' is the default mode.
'Large blocks' produces less artifacts, but has a less precise timing. 'Small blocks'
has a precise timing, but more artifacts.
Change the Lfo1 SHAPE to a triangle for a forward and backward playback.
Change Lfo1 SPEED for a faster or slower playback of the sound. When you set
SPEED to 0 you can timefreeze the sample. You can use the WAVE knob to
change the start offset of the sound. The pitchwheel changes the pitch of the
sample without affecting the playback speed.

•

Vocoder button

The vocoder module of Icarus offers the highest possible sound quality: It has over 500 bands
and ultra fast envelopes.
Click on the VOCODER button, select 'Easy create patch: Vocoder Poly' and select a vocal
sample or a drumline in wav format. A complete vocoder patch is created instantly. Use the
Lfo1 SPEED knob to change the playback speed of the vocoder. Use the MORPH knob to
shift the formants up and down.

TIP: Apply 'OSC->TOOL->Modify Wavetable: Maximize Volume' for one or several times to

boost the volume.
The following Vocoder options are available:
◦ Easy create patch: Vocoder Poly Classic - A classic vocoder sound with a
sawtooth as carrier wave. A good choice if you want to play chords.
◦ Easy create patch: Vocoder Poly Robo Stack - The 90s robotic vocoder sound
known from many old Freestyle recodings. It uses two stacked sawtooths as carrier
wave.
◦ Easy create patch: Vocoder Poly Breathy - A unique, breathy sounding vocoder
which is only available in Tone2 Icarus. A good choice if you want to play chords.
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◦ Easy create patch: Vocoder Poly Hollow - A vocoder with a squarewave as
carrier. It has a hollow sound.
◦ Easy create patch: Vocoder Poly Noise - A vocoder with a noise as carrier. It
sounds like whispering.
◦ Easy create patch: Speech Synthesis Solo Singer - Creates a monophonic
patch which sounds like the famous 'Cher' record 'Do you believe'.The 'Cher effect'
means that singing phrase is overprocessed with an autotune processor to achieve
an artificial sound. Use the GLIDE knob to control the speed of the legato. Use the
MORPH knob to shift the formants up and down.
TIP: Play legatos (2 keys are pressed, one is released).
TIP: You can make it sound even more artificial if you apply 'OSC->Tool->Modify

Wavetable: Enhance Spectrum'
What is a vocoder?
Simply put, a vocoder puts the ‘characteristics’ of one sound onto another. Originally
designed in the 1930s as a method of encoding a person’s voice for secure
communication over a telephone network, it found a home in modern music during the
1970’s.
A more detailed explanation goes like this. A vocoder needs two inputs, a carrier and a
modulator. The tonal characteristics of the modulator are impressed onto the sound of the
carrier. The modulator is usually a voice, drum loop or other percussive sound. This sound is
passed through many parallel filters to create a ‘signature’ of the modulator from the
frequency content and volume of the frequency components. This multi-frequency, time-varied
‘signature’ is then used to filter the carrier which is usually a frequency rich sustained sound
(like chords played using a sawtooth wave). If you use a voice as the modulator the output
sounds like the sawtooth wave modulated by the filter created by the voice
•
Shop button – The Shop button will take you to Tone2's sound shop, where you can
purchase new soundsets or expansions for Icarus.
•

Help button – Opens Icarus' PDF manual
The Sound section also holds several master controls that shape the overall sound of the
current patch.

17

•

Modwheel– This Modwheel control transmits MIDI Continuous Controller 1 messages
(modulation wheel) when modified. Controlling this knob with your mouse does the
same job as moving the modulation wheel on your keyboard controller. The Modwheel
knob also acts as a visual indicator for your modulation wheel. By default, MIDI
Continuous Controller 1 is used to change, or 'morph' between one timbre and another.

•

Pitchwheel – The pitchwheel controls the amount of pitch bend (portamento) applied
to your sound.

•

Volume – The Volume knob provides a master volume control for Icarus.

•

Vel – The Vel knob controls the amount of keyboard velocity applied to the volume.

•

Glide – The glide knob controls the oscillators' glide speed, gliding occurs if you set the
glide knob to a value larger than 0. Several glide modes are available and can be
setup using Icarus' Setup menu.
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The Oscillator Section
Icarus’ oscillators generate tones through a multiple of different methods which can later be
shaped by the filters and effects processors. Each of the three available oscillators offer
several synthesis methods along with different play modes, wavetables & wave modifiers.
The oscillator section holds a lot of controls so an explanation will be given for each section:

Oscillator top menu
•

Editor – The editor button opens the Wavetable editor, which can be used to further
manipulate & shape your wave.

The Wavetable Editor
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The Wavetable editor offers a wide range of tools and options to edit your wavetable using
waveform, spectrum and phase editors. With the help of these tools you can further shape
your wavetable or single wave any way you want to.
The Wavetable editor screen is split into several sections, which we'll describe in more detail
below.
Wavetable Strip Display

The Wavetable Strip display provides you with an easy overview of your wavetable, displaying
all of the wavetable's slots. An Icarus wavetable contains all waveforms in series and consists
of 1 to 256 waveforms.
Select a single waveform by clicking inside the wavetable strip. The currently selected and
displayed waveform is blue. You can also select a block of several waveforms if you click on
the wavetable strip and move your mouse, the selected waveforms are blue or red, the
currently displayed waveform is blue.
To add a new slot click on the plus sign at the end of the wavetable. The magnifier icons
found on the top right allow you to zoom in or out of your wavetable.
Just below the wavetable strip, two preview keyboards are provided to listen to either the
complete wavetable or currently selected wavetable slot, the left keyboard is used to play the
wavetable, whereas the right keyboard will only play back the selected slot.
A speed control (found in the middle of these keyboards) is provided to set the wavetable's
playback speed.
Drag & Drop
You can drag & drop a wav file which contains a wavetable, waveform (a wave with a single
cycle waveform - 2048 samples length or less) or audio data to a slot of the wavetable strip.
Icarus will load the waveform to that specific slot.
You can also drag & drop several wave files which contain single cycle waveforms (2048
samples length or less) to a slot of the wavetable strip. Icarus will replace all slots, followed
by this slot with the new waveforms.
You can INIT a new wavetable (Create Wavetable: Saw Square Sine) and then drag & drop
several waveforms to the first slot to create a custom wavetable.
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Drag & Drop on waveform display
If you drag & drop a waveform to the large blue waveform display, Icarus will load the
waveform to the currently displayed wavetable slot.
You can also drag&drop several wave files which contain single cycle waveforms (2048
samples length or less) to the waveform display. Icarus will replace all slots, which are
following the currently displayed waveform, with the files.
Wavetable Tool & Options section
The Tool / Options section gives you access to all
wavetable edit, file and initialization functions. Use
the tool section to create & edit your own wavetable
or import a wavetable from disc.
The following tools & options are offered:
•

File – The file menu contains all wavetable / wave
load and save options.
◦ Load Wavetable (N*2048 samples, Icarus,
Serum, Falcon) – Loads a wavetable in the
Icarus wav format (N*2048 samples)
It also works with wavetables from synths like
Serum or Falcon.
◦ Load Waveform to selection – Loads a
waveform to the selected wavetable slot.
◦ Save Wavetable – Saves the wavetable to disc.
Icarus wavetables are compatible with many
other synthesizers and audio editors from other
companies.
An Icarus wavetable is in the common wav file format (16 bit mono) and contains all
waveforms in series. A wavetable can consist of 1 to 256 waveforms. Each singlecycle waveform is exactly 2048 samples long.
A wav file containing a wavetable with 3 waveforms has a length of 3 x 2048
samples.
◦ Save Waveform – Saves the currently selected waveform to disc.
◦ Import Wavetable – Imports a wavetable.
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•

Init – The Init menu contains several initialization options.
◦ Create Wavetable: Saw Square Sine – Creates a three slot Wavetable that
contains a Saw, Square and Sine wave.
◦ Create Wavetable: PWM – Creates a Wavetable using PulseWidth Modulated
waves.
◦ Create Wavetable: Random – Creates a randomized Wavetable.
◦ Init Selection: Saw – Initialises the currently selected Wavetable slot to a Saw
wave.
◦ Init Selection: Square – Initializes the currently selected Wavetable slot to a
Square wave.
◦ Init Selection: Sine – Initializes the currently selected Wavetable slot to a Sine
wave.
◦ Init Selection: Triangle – Initializes the currently selected Wavetable slot to a
Triangle wave.
◦ Init Selection: White Noise – Initializes the currently selected Wavetable slot to a
White Noise wave.
◦ Init Selection: Pink Noise – Initializes the currently selected Wavetable slot to a
Pink Noise wave.
◦ Init Selection: Random Phase – Randomizes the Phase values for the currently
selected Wavetable slot.
◦ Init Selection: Random Spectrum – Randomizes the Spectral values for the
currently selected Wavetable slot.
◦ Init Selection: Random Harmonic – Randomizes the Harmonic values for the
currently selected Wavetable slot.
◦ Init Selection: Silence – Insert Silence into the currently selected Wavetable slot.
◦ Rename to MyWavetable – Rename the current wavetable name to MyWavetable.
TIP: Save a wavetable with the file name of your choice and reload it to get a name
of your choice.
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•

Undo / Redo – Use the Undo / Redo button to compare and undo changes that you
made within the editor.

•

Copy – Copy the currently selected Wavetable slot.

•

Paste – Paste your copied slot to the currently selected Wavetable slot.

•

Cut – Cuts the currently selected Wavetable slot (note that you can still paste the cut
out slot back into a new slot)

•
Trim – Trims the Wavetable back to include only the selected waves. (if needed use
the undo button to undo this)

•

Sweep – The waveform currently selected by the blue box is picked and a morphing
wavetable with many waveforms is created, replacing the old wavetable. You can find a
detailed description of the different morph modes in the 'morph Modes menu' section of
this handbook. The first slot of the sweep sounds like the MORPH knob set to 0, the
last slot sounds like the MORPH knob set to 100.

TIP: You can undo your changes with 'OSC->Tool->Undo/Redo Wavetable edit'.
TIP: You can use this feature to create smooth filter sweeps and soft transitions for Morph

modes which are 'steppy' like 'Bandpass 1oct'.
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•

Mix – The mix menu offers several mix functions, combined with a slider control to
determine how much of the function is applied. Mouse-click on the Mix button to open
the Mix menu and use the slider control to set the amount.
◦ Mix with copy – Mix the copied data with the
selection (use the Copy button to first copy your
data)
◦ Insert copy – Insert the copied data at the current
selection point.
◦ Crossfade selection – Crossfades the selected
data.
◦ Reverse selection – Reverses the selected data.
◦ Normalize volume – Normalizes the selected
data's volume.
◦ Maximize volume – Applies a maximize process
so waveforms with low volume are boosted
◦ Change volume to value – Changes the volume
(Use the value slider control to set the amount)
◦ Stack Octave+ by value – Stacks an oscillator with another oscillator, one octave
higher. (Use the value slider control to set the amount)
◦ Stack Octave- by value – Stacks an oscillator with another oscillator, octave
higher and with 180 degree phase shifted. (Use the value slider control to set the
amount)
◦ Stack Harmonic+ by value – Stacks an oscillator with another oscillator, two,
three, four, five, six, seven or eight times higher. (Use the value slider control to set
the amount)
◦ Stack Harmonic- by value – Stacks a 180 degree phase shifted oscillator with
another oscillator, two, three, four, five, six, seven or eight times higher. (Use the
value slider control to set the amount) This mode has a more hollow sound than
'Stack Harmonic+'
◦ Stack Power by value – Stacks several oscillators, two, three and four times
higher. (Use the value slider control to set the amount)
TIP: Use this mode together with sinoid waveforms to build organs.

24

◦ Chord 2x by value – Two stacked oscillators play a chord. (Use the value slider
control to set the amount)
◦ Chord 3x by value –Three stacked oscillators play a chord. (Use the value slider
control to set the amount)
◦ PW by value – Applies Pulse-width Modulation. (Use the value slider control to set
the amount)
◦ Comb 2x by value – Applies a comb filter with 2 stages. (Use the value slider
control to set the amount)
◦ Comb 3x by value – Applies a comb filter with 3 stages. (Use the value slider
control to set the amount)
◦ Half size - Cuts the selection into half.

•

Filter – The Filter menu offers several filter functions, combined with a slider control to
determine how much of the function is applied. Mouse-click on the Filter button to open
the Filter menu and use the slider control to set the amount.
◦ Tone warmer by value – Reduces the volume of
high harmonics, making the selection sound
warmer (Use the value slider control to set the
amount)
◦ Tone brighter by value – Boosts the volume of
high harmonics, making the selection sound
brighter (Use the value slider control to set the
amount)
◦ Denoise by value – Applies a Denoise process to
the selection where noise is removed from the
wavetable (Use the value slider control to set the amount)
◦ Lowpass by value – Applies a Lowpass filter to the selection (Use the value slider
control to set the amount)
◦ Highpass by value – Applies a Highpass filter to the selection (Use the value slider
control to set the amount)
◦ Bandpass 1oct by value – Applies a steppy spectral one octave bandwidth filter to
the selection (Use the value slider control to set the amount)
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◦ Bandpass 2oct by value – Applies a steppy spectral two octave bandwidth filter to
the selection (Use the value slider control to set the amount)
◦ Bandstop 1oct by value – Applies a steppy spectral one octave bandstop filter to
the selection (Use the value slider control to set the amount)
◦ Bandstop 2oct by value – Applies a steppy spectral two octave bandstop filter to
the selection (Use the value slider control to set the amount)

•

Modify – The Modify menu offers several modifier functions, combined with a slider
control to determine how much of the function is applied. Mouse-click on the Modify
button to open the Modify menu and use the slider control to set the amount.
◦ Saturate by value – Saturation is applied to the
selected wave(s) (Use the value slider control to set
the amount)
◦ Bitcrush by value – A bitcrush process is applied to
the selected wave(s) (Use the value slider control to
set the amount)
◦ Downsample by value – The selected wave(s) are
downsampled (Use the value slider control to set the
amount)
◦ Add Noise by value – Noise is applied to the selected
wave(s) (Use the value slider control to set the
amount)
◦ Ringmod by value – Ringmodulation is applied to the
selected wave(s) (Use the value slider control to set
the amount)
◦ AM by value – Amplitude Modulation is applied to the
selected wave(s) (Use the value slider control to set
the amount)
◦ Sync Square by value – Applies hard sync to the
selected wave(s) Useful for synced sounds and sharp
sounding sweeps. (Use the value slider control to set
the amount)
◦ Sync Saw by value – Applies hard sync to the selected wave(s) Useful for speech
synthesis, synced sounds and sweeps. (Use the value slider control to set the
amount)
26

◦ Waveshape by value – Waveshaping is applied to the selected wave(s) (Use the
value slider control to set the amount)
◦ FM Sine by value – The selected wave(s) are FM modulated with a sine wave
oscillator. (Use the value slider control to set the amount)
◦ FM Sine 2x by value – The selected wave(s) are FM modulated with a sine wave
oscillator at double frequency. Which provides a hollow sound. (Use the value slider
control to set the amount)
◦ FM Sine 3x by value – The selected wave(s) are FM modulated with a sine wave
oscillator at triple frequency. Which provides a bell like sound. (use the value slider
control to set the amount)
◦ FM Square by value – The selected wave(s) are FM modulated with a square
wave oscillator. (use the value slider control to set the amount)
◦ FM Saw by value – The selected wave(s) are FM modulated with a saw wave
oscillator. (use the value slider control to set the amount)
◦ Harmonic by value – Applies a partial morph with smooth transitions. (use the
value slider control to set the amount)
◦ Hollow1-3 by value – Applies a partial morph with smooth transitions and hollow
sound. (use the value slider control to set the amount)
◦ Hollow Double by value – Applies a partial morph at double frequency, with
smooth transitions and hollow sound. (use the value slider control to set the
amount)
◦ PhaseDist PW by value – Applies Phase Distortion with pulsewidth control to the
selected wave(s) (Use the value slider control to set the amount)
◦ PhaseDist Saw by value – Applies Phase Distortion to the selected wave(s)
Morphing a sine wave to a sawtooth. (Use the value slider control to set the
amount)
◦ PhaseDist Square by value – Applies Phase Distortion to the selected wave(s)
Morphing a sine wave to a square. (Use the value slider control to set the amount)
◦ PhaseDist Double by value – Applies Phase Distortion to the selected wave(s)
Morphing the wave to a wave with double frequency. (Use the value slider control to
set the amount)
◦ Mirror by value – Mirrors the waveform(s) in the middle. (Use the value slider
control to set the amount)
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◦ Grunge by value – Adds additional harmonics to the selected wave(s). (Use the
value slider control to set the amount)

•

Spectrum – The Spectrum menu offers several spectrum edit functions, combined with
a slider control to determine how much of the function is applied. Mouse-click on the
Spectrum button to open the Spectrum menu and use the slider control to set the
amount.
◦ Enhance by value – Enhances the selected wave's
spectrum. The resulting wave(s) usually have more
'character'. (Use the value slider control to set the
amount)
◦ Square harmonics – Every second harmonic is set to
0. It gives a hollow sound. A sawtooth is turned into a
square wave.
◦ N harmonics by value – All harmonics except every
Nth one are set to 0. Value defines the gap distance. It
gives a hollow, bell-style sound. (Use the value slider
control to set the amount)
◦ Organ harmonics by value – All harmonics except the power of N^M are set to 0.
Value defines the gap distance. It gives an organ-style sound. (Use the value slider
control to set the amount)
◦ Bell harmonics by value – All harmonics except the power of N are set to 0.
Value defines the gap distance. It gives a bell-style sound. (Use the value slider
control to set the amount)
◦ Shift up – All harmonic are moved upwards. It results in a bright sound, which can
be one octave higher.
◦ Shift down – All harmonic are moved downwards. It results in a darker sound.
◦ Stretch – All harmonics are duplicated and the spectrum is stretched. It results in a
brighter sound.
◦ Shrink – Every second harmonic is removed and the spectrum is shrinked. It
results in a darker sound.
◦ Interval by value – Creates a harmonic interval. With a value set to 0 it will play the
base frequency. Higher values result in a frequency 2,3,4,5,6,7 or 8 times higher.
(Use the value slider control to set the amount)
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•

Phase – The Phase menu offers several phase edit functions, combined with a slider
control to determine how much of the function is applied. Mouse-click on the Phase
button to open the Phase menu and use the slider control to set the amount.
◦ Set to 0 – Sets the selection's phase to zero.
◦ Set to value – Sets the phase(s) to a specific value. (use the value slider control to
set the amount)
◦ Invert – Inverts the selection's phase.
◦ Silky – Modifies the selection's phase to sound more
silky.
◦ Noisy – Modifies the selection's phase to sound more
noisy.
◦ Sweep by value – Applies a phase sweep to the
selection. (use the value slider control to set the
amount)
◦ Reverse – Reverses the selection's phase.
◦ Optimize phases to reduce rumble – When you morph trough a wavetable with
the WAVE knob you sometimes hear some rumbling or detuning. The Optimize
phases.... option reduces rumbling and detuning.

•

Resynthesis – Resynthesizes and creates a wavetable from an imported sample.
◦ Resynthesis – Resynthesize uses the default mode, which gives the best results
for most sounds.
◦ Resynthesis Additive – Works like the default Resynthesis, but removes all phase
information and detuning from the sample. As a result you get the cold sound
known from additive synthesizers.
◦ Resynthesis for Noisy sounds – Works like the normal resynthesis, but
sometimes gives better results with very noisy sounds like flutes.
◦ Resynthesis Note=C4 – Resynthesize from a sample tuned to C4.
◦ Resynthesis Note=C3 – Resynthesize from a sample tuned to C3
◦ Resynthesis Note=C2 – Resynthesize from a sample tuned to C2
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◦ Resynthesis Note=C1 – Resynthesize from a sample tuned to C1
◦ Resynthesis Note=C0 – Resynthesize from a sample tuned to C0
◦ Granular – Creates a wavetable using granular synthesis. In granular synthesis a
sample is divided into small 'grains' with a window function.

•

Vocoder – Creates a Vocoder Wavetable using an imported sample.
◦ Vocoder Saw – Creates a Vocoder Wavetable using a Saw wave carrier.
◦ Vocoder Square – Creates a Vocoder Wavetable using a Square wave carrier.
◦ Vocoder Silky – Creates a Silky Vocoder Wavetable.
◦ Vocoder Noise – Creates a Vocoder Wavetable using a Noise wave carrier.

Editor / Display Mode
The Editor / Display mode buttons
allow you to switch between the
available editor modes.

◦ Exit – Exits the Wavetable editor and switches back to the synthesizer.
◦ Waveform – Switches the editor to Waveform mode. Inside Waveform mode you
can edit the raw waveshape. A complete set of draw tools are provided (bottom left
of the wave display) to help you edit your waveform, a description of these tools is
found in the Wave/Spectrum/Phase display section.
◦ Spectrum – Switches the editor to Spectrum mode. Inside the spectrum mode you
can change the amplitude of each partial.
◦ Phase – Switches the editor to Phase mode. Inside Phase mode you can directly
edit the phase spectrum, which can add breathiness, detune harmonics or help
make organic timbres.
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Wave / Spectrum / Phase Display

The Wave/Spectrum/Phase Display section allows you to directly edit, as well as provide you
with a visual display of, the current waveform(s)
The type of editor display is switchable by either clicking on the Waveform, Spectrum or
Phase button.
In Waveform mode an additional Toolbar with draw tools is provided to help you further edit
your waveform.
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Oscillator top menu
•

Tool – The Tool menu offers you several oscillator related options.

Options available are:
◦ Copy current Osc to Osc1 - Copies all settings from the current oscillator to
oscillator 1.
◦ Copy current Osc to Osc2 - Copies all settings from the current oscillator to
oscillator 2.
◦ Copy current Osc to Osc3 - Copies all settings from the current oscillator to
oscillator 3.
◦ Reset all Oscs – Resets all oscillator settings (Osc1,2,3) and loads the default
wavetable.
◦ Reset current Osc – Resets the current oscillator settings and loads the default
wavetable.
◦ Save Wavetable – Dumps the wavetable of the currently selected oscillator to
disc. Icarus wavetables are compatible with many other synthesizers and audio
editors, also from other companies. While many audio companies encrypt their
wavetables to prevent that they can be copied we think that wavetable synthesis
can only make a step forward if there is an interchangeable, open and well
documented file format that anyone can use and edit.
An Icarus wavetable is in the common wav file format (16 bit mono) and contains all
waveforms in series. Each single-cycle waveform is exactly 2048 samples long. A
wav file containing a wavetable with 3 waveforms has a length of 3x2048 samples.
A wavetable can consist of 1 to 256 waveforms.
TIP: A wavetable can contain also just one single waveform. Then it can't be

morphed with the WAVE knob, but it can be imported to a slot of a wavetable.
TIP: You can save a wavetable, use an external audio editor like Wavelab or

Goldwave to modify it and reload it back to Icarus.
TIP: If you want to export not the complete wavetable, but a single-cycle waveform

use 'OSC->Tool->Trim Wavetable: Pick current waveform' to create a wavetable
with only one waveform first. Then save the wavetable.
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TIP: For a quick access to your own wavetables you can add your own custom files

to the factory content of Icarus. When Icarus is loaded all wavetables within the
Icarus_wavetables directory are scanned and displayed within the oscillators. The
Icarus wavetables are stored as wav files within the Icarus_wavetables directory.
On PC this directory can be found within your vstplugins directory. On Mac it is
within Library/Audio/Plug-ins.
TIP: Icarus patches are in fxp format. The fxp files contain the current patch setting,

but do also contain the wavetable data. The wavetable data is also stored directly
within your songs. You don't have to care or be scared about the content of the
Icarus_wavetables directory. Even if you should accidentally delete all factory
wavetables, your songs an all Icarus patches will not be broken and continue to
work.
◦ Load Wavetable (N*2048 samples, Icarus, Serum, Falcon) – Loads a wavetable
which has the Icarus wav format (N*2048 samples) to the currently selected
oscillator. It does also work with wavetables from some other synths like Serum or
Falcon.
TIP: You can also drag&drop an Icarus wavetable to the 3D display of the oscillator

to load it.
◦ Load Waveform to current WAVE position – Loads a waveform to the wavetable
slot, which is selected by the WAVE knob. A waveform is a wav file with 2-2048
sample length and contains a single cycle waveform. If you load a larger wav file a
waveform is automatically resynthesized from the middle of this sample.
TIP: Icarus can handle very complex waveforms. It's even possible to load short

samples (less than 2048 samples samplelength) as a waveform to a wavetable.
This can be useful to build a drum set or for transient attack sounds.
TIP: Icarus supports drag & drop of one or several wav files to the 3D display of the

oscillator. When you use drag & drop the waveform is loaded to the wavetable slot,
which is currently selected by the WAVE knob.
◦ Undo/Redo Wavetable Edit – Use this to compare and undo changes that you
made with the OSC Tool menu.
◦ Create Wavetable: Random – Icarus can create an unlimited amount of
wavetables! The wavetable of the currently selected oscillator is replaced with a
new one. Use the WAVE knob to select the currently played waveform.
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◦ Create Wavetable: Resynthesis – Analyzes a wav file and resynthesizes a
wavetable. The wavetable of the currently selected oscillator is replaced with the
new one.
There are many synthesizers which are advertized to be capable to do
'resynthesis'. However the results that these products give are usually poor: Most
products produce heavy rumble when a sample isn't tuned exactly, they fail with
chords, they fail with voices, they fail with many natural sounds and they fail with
pitch slides. We have taken care of all the problems.
In Icarus you don't have do care about tuning or the content that you load. Simply
select a short sample of you choice in wav file format and wait for some seconds.
TIP: Click on the RESYNTHESIS button and select 'Easy create patch: Resynthesis'

to create a complete patch which sounds very similar to the original wav file
automatically.
TIP: Use mono wav files in high quality. If the original sample sounds crappy the

results of the resynthesis will also sound crappy.
TIP: Once you resynthesized a wav file you can use the WAVE knob and LFO1 to

time-stretch it.
TIP: Select 'Formant' or 'Format Cross' as Morph Mode and use the MORPH knob

to pitchshift it.
◦ Create Wavetable: Resynthesis Additive – Works like the previous one, but
removes all phase information and detuning from the sample. As a result you get
the cold sound known from additive synthesizers.
TIP: Later you can use the spectral editor to change the partials and to turn Icarus

into a complete additive synthesizer!
TIP: Click on the RESYNTHESIS button and select 'Easy create patch: Additive

Resynthesis' to create a complete patch which sounds quite similar to the original
wav file automatically.
◦ Create Wavetable: Resynthesis for Noisy sounds – Works like the normal
resynthesis, but sometimes gives better results with very noisy sounds like flutes.
◦ Create Wavetable: Resynthesis Note=C4-C0 – In these modes Icarus doesn't
detect the pitch of the samples automatically. The sample that you load must be
tuned exactly to C4,C3,...
TIP: This mode can be useful if you recorded synthesizer sounds.
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◦ Create Wavetable: Vocoder Raw – Analyzes a wav file and prepares a wavetable
for the use with the Vocoder Morph Mode. The wavetable of the currently selected
oscillator is replaced with the new one.
The vocoder module of Icarus offers the highest possible sound quality: It has over
500 bands and ultra fast envelopes.
TIP: Click on the VOCODER button, select 'Easy create patch: Vocoder' and select

a vocal sample to create a complete vocoder patch instantly. Use the Lfo1 SPEED
knob to change the speed of the vocoder sample.
TIP: Use 'Vocoder' as Morph Mode and the MORPH knob to change the formant

frequency.
TIP: You can apply 'Tool->Modify Wavetable: Maximize Volume' for one or several

times to boost the volume.
◦ Create Wavetable: Vocoder Square – Is like the previous one, but the resulting
wavetable has a hollow sound. Use this mode to emulate a vocoder with a square
wave as carrier.
◦ Create Wavetable: Vocoder Silky– Is like the previous ones, but the resulting
wavetable has a silky sound.
◦ Create Wavetable: Vocoder Noise – Is like the previous ones, but the resulting
wavetable has a noisy sound. Use this mode to emulate a vocoder with noise as
carrier.
◦ Create Wavetable: Granulator – Analyzes a wav file and prepares a wavetable for
the use with the Granulator Morph Mode. The wavetable of the currently selected
oscillator is replaced with the new one.
TIP: Click on the RESYNTHESIS button, select 'Easy create patch: Granulator' and

select a sample to create a complete granular patch instantly. Use the Lfo1 SPEED
knob to change the speed of the sample. Use the MORPH knob to change the
pitch of the sample.
◦ Trim Wavetable: Pick current waveform – Only the waveform which is selected
by the WAVE knob remains. All other waveforms within the wavetable are thrown
away.
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TIP: A wavetable, which contains just one single waveform, can't be morphed with

the WAVE knob. Use 'OSC->Tool->Extend Wavetable: Add one slot' to extend the
wavetable with one additional waveform slot.
TIP: If you want to export not the complete wavetable, but a single-cycle waveform

use 'OSC->Tool->Trim Wavetable: Pick current waveform' to create a wavetable
with only one waveform first. Then save the wavetable.
TIP: If your patch only uses a single waveform which is part of a large wavetable,

you can use this function to reduce the size of your songs and the size of the fxp
after saving.
◦ Trim Wavetable: After current waveform – All waveforms behind the one
selected by the WAVE knob are thrown away.
◦ Trim Wavetable: Before current waveform – All waveforms before the one
selected by the WAVE knob are thrown away.
◦ Extend Wavetable: Add one slot – Adds an additional slot to the end of the
wavetable.
TIP: A wavetable, which contains just one single waveform, can't be morphed with

the WAVE knob.
◦ Apply Morph to Wavetable – This is a very powerful feature which is unique to
Icarus and not available in any other synthesizer. It allows you to apply an unlimited
number of morphs to a wavetable! As a result you get an easy access to an literally
unlimited number of different wavetables. All morph modes can be pre-rendered to
a wavetable by using 'OSC->TOOL->Apply Morph to Wavetable'. The currently
selected value of the MORPH knob is used as a parameter for the rendering. After
rendering the old wavetable is replaced with a new one. The playback mode will
switch to the default 'None / Partial' which doesn't alter the sound anymore. Please
note that the morphing is done with the WAVE knob instead of the MORPH knob
now. Get ready to apply another Morph mode!
TIP: You can undo your changes with 'OSC->Tool->Undo/Redo Wavetable edit'.
TIP: Use the FADE knob to define how steppy transitions between waveforms are.
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◦ Apply Morph Sweep to current Waveform – This one works similar to the
previous one, but with a little different rendering parameters. The waveform which is
currently selected by the WAVE knob is picked. A wavetable with many waveforms,
which replaces the old one, is created. The first slot sounds like the MORPH knob
set to 0, the last slot sounds like the MORPH knob set to 100. The playback mode
will switch to the default 'None / Partial' which doesn't alter the sound anymore.
Please note that the morphing is done with the WAVE knob instead of the MORPH
knob now. Get ready to apply another Morph mode!
TIP: You can undo your changes with 'OSC->Tool->Undo/Redo Wavetable edit'.
TIP: Use the FADE knob to define how 'steppy' transitions between waveforms are.
TIP: You can use this feature to create smooth filter sweeps and soft transitions for

Morph modes which are 'steppy' like 'Bandpass 1oct'.
◦ Modify Wavetable: Tone warmer 1.5dB/Oct– Reduces the volume of high
harmonics.
TIP: Use it for a more 'analog' and warm sound or if a wavetable sounds too 'sharp'.
TIP: You can apply this for several times for an even more warm sound.

◦ Modify Wavetable: Tone brighter 1.5dB/Oct – Boosts the volume of high
harmonics.
TIP: Use it for supersaw sounds or if a wavetable sounds too muffled.
TIP: You can apply this for several times.

◦ Modify Wavetable: Silky – The wavetable sounds more silky and noisy.
TIP: Use it for string sounds.

◦ Modify Wavetable: Square – All even harmonics get removed. As a result a
sawtooth will be turned into a hollow sounding square wave.
TIP: If you don't like the results you can undo it with 'Tool->Undo/Redo Wavetable

edit'.
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◦ Modify Wavetable: Denoise – Noise is removed from the wavetable. Sometimes
the resulting wavetable does have more 'character'.
TIP: If you don't like the results you can undo it with 'Tool->Undo/Redo Wavetable

edit'.
◦ Modify Wavetable: Add Noise – Adds some garbage to the wavetable.
TIP: You can apply this for several times for more intensity.

◦ Modify Wavetable: Optimize phases – When you morph trough a wavetable with
the WAVE knob you sometimes can hear some rumbling or detuning. After applying
this one rumbling is the reduced and the detuning is removed.
◦ Modify Wavetable: Enhance Spectrum – The resulting wavetable mostly has
more 'character'.
TIP: If you don't like the results you can undo it with 'Tool->Undo/Redo Wavetable

edit'.
◦ Modify Wavetable: Maximize Volume – Waveforms with low volume are boosted.
TIP: You can apply this for several times for more intensity.

◦ Rename Wavetable to MyWavetable – When you load a wavetable the name
within the oscillator is replaced with the name of the previously loaded file. For the
case that you don't like the new name or for the case that no one ever should know
the file name of the stuff that you've imported you can set the wavetable name to
MyWavetable.
TIP: Save a wavetable with the file name of your choice and reload it to get a name

of your choice.

•

1 – Switches the oscillator display & panel to oscillator 1.

•

2 – Switches the oscillator display & panel to oscillator 2.

•

3 – Switches the oscillator display & panel to oscillator 3.

•

ON – Switches the current oscillator to On / Off.
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Waveform display

The waveform display shows the current wave(table) Any changes to the waveform are
automatically updated & displayed.
TIP: By right-clicking within the waveform display you can switch between the different ways a

wavetable is displayed/

Just beneath the waveform display you'll see three menu controls, these are:
•

Play Mode menu – This menu offers several Play Mode options. The following modes
are available:
◦ Mono - Single oscillator. This is the classic mode which is used by conventional
synthesizers
◦ HyperSaw 3, 5, 7, 9 - Several detuned oscillators play at the same time. Unlike
conventional Hypersaw synthesizers, the Hypersaws in Icarus are phase optimized.
This means that the amount of beating is minimized statistically. As a result you get
a sound which suffers from less gain peaks and has more bottom. The Hypersaw
oscillators of conventional synthesizers use only sawtooths. In Icarus you can
combine this mode with any kind of waveform or wavetable. The detune knob
controls the amount of detuning.
◦ HyperStereo 4,6,8,10 - Several detuned stereo oscillators play at the same time.
The oscillators are phase optimized. This means that the amount of beating is
minimized statistically. As a result you get a sound which suffers from less gain
peaks and which has more bottom. The detune knob controls the amount of
detuning.
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◦ Unison 2 - Two detuned oscillators are stacked. The detune knob controls the
amount of detuning.
◦ Unison 2 Stereo - Two detuned oscillators play at the same time. The left oscillator
is tuned up, the right oscillator is tuned down. The detune knob controls the amount
of detuning.
◦ Unison 4 - Four detuned oscillators are stacked. The detune knob controls the
amount of detuning.
◦ Unison 4 Stereo - Four detuned stereo oscillators play at the same time. The
detune knob controls the amount of detuning.
◦ Unison Oct - Two detuned oscillators are stacked. The second oscillator plays one
octave higher. The detune knob controls the amount of detuning.
◦ Unison Oct Stereo - Four detuned stereo oscillators are stacked. The second pair
plays one octave higher. The detune knob controls the amount of detuning.
◦ SuperSaw - Nine detuned oscillators play at the same time. This mode provides
the classic 'Trance' sounds from the late 90s. Unlike conventional synthesizers with
Supersaw you can combine this mode with any kind of waveform or wavetable. The
detune knob controls the amount of detuning.
◦ Stack 2:1 Octave - Two detuned oscillators are stacked. The second oscillator
plays one octave higher. The detune knob controls the amount of detuning.
◦ Stack 3:1 - Two detuned oscillators are stacked. The second oscillator plays one
octave and a fifth higher. The detune knob controls the amount of detuning.
◦ Stack 4:1 - Two detuned oscillators are stacked. The second oscillator plays two
octaves higher. The detune knob controls the amount of detuning.
◦ Stack 5:1 - Two detuned oscillators are stacked. The frequency of the second
oscillator is five times higher. The detune knob controls the amount of detuning.
◦ Stack 3:2 Fifth - Two detuned oscillators are stacked. The second oscillator plays a
fifth higher. The detune knob controls the amount of detuning.
◦ Stack 5:2 - Two detuned oscillators are stacked. The second oscillator plays 2.5
times higher. The detune knob controls the amount of detuning.
◦ Stack 4:3 Quart - Two detuned oscillators are stacked. The second oscillator plays
1.33 times higher. The detune knob controls the amount of detuning.
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◦ Stack 5:3 - Two detuned oscillators are stacked. The second oscillator plays 1.66
times higher. The detune knob controls the amount of detuning.
◦ Stack 5:4 Major - Two detuned oscillators are stacked. The second oscillator plays
a major third higher. The detune knob controls the amount of detuning.
◦ Stack 6:5 Minor - Two detuned oscillators are stacked. The second oscillator plays
a minor third higher. The detune knob controls the amount of detuning.
◦ Interval - Single oscillator is playing. The detune knob controls the harmonic
interval. If it is set to 0 it will play the base frequency. Higher values result in a
frequency which is 2,3,4,5,6,7 or 8 times higher.
◦ Third Maj/Min - Two detuned oscillators are stacked. The second oscillator plays a
minor or major third higher. The detune knob controls the amount of detuning.
◦ Third Maj/Min 2 - Three detuned oscillators are stacked. The second oscillator
plays an octave higher. The third oscillator plays a minor or major third higher. The
detune knob controls the amount of detuning.
◦ Third Maj/Min 3 - Three detuned oscillators are stacked. The second oscillator
plays an octave higher. The third oscillator plays an octave and a minor or major
third higher. The detune knob controls the amount of detuning.
◦ Fifth Oct - Three detuned oscillators are stacked. The second oscillator plays an
octave higher. The third oscillator plays an octave and a fifth higher. The detune
knob controls the amount of detuning.
◦ Chord1 - Plays a major or minor chord. The detune knob controls the amount of
detuning.
◦ Chord2 - Plays a major or minor chord and one octave lower. The detune knob
controls the amount of detuning.
◦ Flange 3x - Three slightly detuned oscillators are stacked to achieve a flanging
effect. The detune knob controls the modulation speed.
◦ Flange 5x - Five slightly detuned oscillators are stacked to achieve a flanging
effect. The detune knob controls the modulation speed.
◦ Flange 6x Stereo - Six slightly detuned oscillators are stacked to achieve a stereo
flanging effect. The detune knob controls the modulation speed.
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Waveshape menu – This menu is used to select which waveshape the current
oscillator should use. Note: external wavetables can be loaded by using the File menu
found on top of the Oscillator panel. The two arrow shaped controls found on the left of
the Waveform display are used to navigate forward / backward through the Waveshape
list.

•

•

Morph Modes menu – The morph modes are different playback mode for the
wavetables. The MORPH knob varies the way how the morph mode affects the
wavetable. Next to the WAVE knob it provides another dimension to change the
oscillator's sound. No other synthesizer offers as many playback modes for wavetables
as Icarus does. All morph modes are processed in realtime, which means that you hear
all changes immediately and you can route any modulation source to MORPH and
WAVE within the matrix.
TIP: You can apply an unlimited number of morphs to the wavetable! As a result you'll

get easy access to literally an unlimited number of different wavetables. This feature is
unique to Icarus and not available in any other synthesizer. Most morph modes can be
pre-rendered to a wavetable by using 'OSC->TOOL->Apply Morph to Wavetable' and
'OSC->TOOL->Apply morph sweep to current waveform'.
As soon as you pre-rendered the MORPH, the playback mode will switch to 'None /
Partial' and you can apply another Morph mode. You can undo your changes with
'OSC->Tool->Undo/Redo Wavetable edit'.
TIP: As soon as you pre-rendered a morph to a wavetable you can use WAVE to

morph, use the LFO1 knob to modulate the morph and use FADE to define whether
you want a quantized or smooth transitions.
TIP: When you move the MORPH knob you will notice audible stepping on some morph

modes (Bandlimit, Ringmod, Bandpass, ...). This stepping is useful for many sounds. If
you want smooth transitions select 'OSC->TOOL->Apply Morph Sweep to Wavetable'.
Set the 'FADE' knob to 100. Then use WAVE for a smooth transition. The following
Morph modes are available:
◦ Non / Partial - This is the default mode for wavetable playback. If the value of the
MORPH knob is set to 0 the original wavetable, without any changes applied, is
played back. Larger values remove partials from the signal.
TIP: When you move the MORPH knob you will notice an audible stepping. If you

want smooth transitions select 'Lowpass fade' as morphmode instead.
TIP: This mode offers the highest sound quality and doesn't need much CPU. You

should use this mode, except you want to morph the wavetable in realtime or
except the case that you are using morphmodes which use fixed formant
frequencies.
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All other morph modes can be pre-rendered to the wavetable by using 'OSC>TOOL->Apply Morph to Wavetable' and 'OSC->TOOL->Apply morph sweep to
current waveform'.
◦ Formant - This mode is useful for speech synthesis, synced sounds and sweeps.
The sound of the wavetable will change in a way that the frequency content sounds
similar, no matter what key you press on the keyboard.
Low values of the MORPH knob result in a darker sound, high values result in
sounds with lots of energy in the high spectrum.
TIP: Use the LFO2 knob for cool morphs.

◦ Formant Cross - Similar to Formant, but with a softer sound.
TIP: Use the LFO2 knob for cool morphs.

◦ Ringmod Fade - Ringmodulation with a fixed frequency is applied to the
wavetable. The sound of the wavetable will change in a way that the frequency
content sounds similar, no matter what key you press on the keyboard.
TIP: This mode sounds similar to a filter sweep. Use the LFO2 knob and MORPH to

modulate the 'filter cutoff'.
◦ Ringmod Key - Ringmodulation with key tracking is applied to the wavetable.
◦ Ringmod - Ringmodulation with key tracking and stepping is applied to the
wavetable.
◦ AM Fade - Amplitude modulation with a fixed frequency is applied to the wavetable.
The sound of the wavetable will change in a way that the frequency content sounds
similar, no matter what key you press on the keyboard.
TIP: Use the LFO2 knob to modulate it.

◦ AM Key - Amplitude modulation with key tracking is applied to the wavetable.
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◦ AM - Amplitude modulation with key tracking and stepping is applied to the
wavetable.
◦ Waveshape - A waveshaper is applied to the wavetable. It gives a FM-like sounds.
TIP: Use the LFO2 knob to modulate it.

◦ FM Sine - The wavetable is FM modulated with a sine wave oscillator.
TIP: Use it together with a sine wave or another dark waveform. Use the LFO2

knob to modulate it.
◦ FM Sine 2x - The wavetable is FM modulated with a sine wave oscillator with
double frequency. It has a hollow sound.
TIP: Use it together with a sine wave or another dark waveform. Use the LFO2 knob

to modulate it.
◦ FM Sine 3x - The wavetable is FM modulated with a sine wave oscillator with triple
frequency. It has a bell-like sound.
TIP: Use it together with a sine wave or another dark waveform. Use the LFO2 knob

to modulate it.
◦ FM Square - The wavetable is FM modulated with a square wave oscillator. Please
note that the FM modes in Icarus are real frequency modulation, not PM (phase
modulation). Nearly all conventional 'FM' synthesizers (except Tone2 Nemesis) in
fact do only PM, which is more easy to process, but doesn't give musically useful
sounds on complex waveforms.
TIP: Use it together with a sine wave or another dark waveform. Use the LFO2 knob

to modulate it.
◦ FM Saw - The wavetable is FM modulated with a saw wave oscillator.
TIP: Use it together with a sine wave or another dark waveform. Use the LFO2 knob

to modulate it.
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◦ Sync Square Key - Applies hard sync with key tracking to the oscillator. This mode
is useful for synced sounds and sharp sounding sweeps.
TIP: Use the LFO2 knob to modulate it.

◦ Sync Square - Applies hard sync to the oscillator. This mode is useful for speech
synthesis, synced sounds and sweeps. The sound of the wavetable will change in a
way that the frequency content sounds similar, no matter what key you press on the
keyboard.
TIP: Use the LFO2 knob for cool morphs.

◦ Sync Saw Key - Applies hard sync with key tracking to the oscillator. This mode is
useful for synced sounds and sharp sounding sweeps.
TIP: Use the LFO2 knob to modulate it.

◦ Sync Saw - Applies hard sync to the oscillator. This mode is useful for speech
synthesis, synced sounds and sweeps. The sound of the wavetable will change in a
way that the frequency content sounds similar, no matter what key you press on the
keyboard.
TIP: Use the LFO2 knob for cool morphs.

◦ Harmonic Key - A partial morph with smooth transitions and key tracking.
TIP: Use the LFO2 knob for cool morphs.

◦ Harmonic - A partial morph with smooth transitions. The sound of the wavetable
will change in a way that the frequency content sounds similar, no matter what key
you press on the keyboard.
TIP: Use the LFO2 knob for cool morphs.

◦ Hollow Key 1-4 - A partial morph with smooth transitions and key tracking. It has a
hollow sound.
TIP: Use the LFO2 knob for unique filter sweeps.
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◦ Hollow - A partial morph with smooth transitions and a hollow sound. The sound of
the wavetable will change in a way that the frequency content sounds similar, no
matter what key you press on the keyboard.
TIP: Use the LFO2 knob for unique filter sweeps.

◦ Lowpass Fade - A spectral lowpass filter with at least 80dB is applied to the
wavetable. Unlike conventional filters it doesn't suffer from phase shift and gives
extremely precise results. It has a very unique sound and is excellent for punchy
bass sounds with lots of pressure. This filter is exclusive and only available in
Tone2 Icarus and Tone2 Nemesis.
TIP: Use the LFO2 knob and MORPH to modulate the filter cutoff.

◦ Highpass Fade - A spectral highpass filter with at least 80dB is applied to the
wavetable. This filters is exclusive and only available in Tone2 Icarus.
TIP: Use the LFO2 knob and MORPH to modulate the filter cutoff.

◦ Highpass - A steppy spectral highpass with over 120dB(!) is applied to the
wavetable.
◦ Bandpass 1oct - A steppy spectral bandpass with over 120dB(!) and one octave
bandwidth is applied to the wavetable.
TIP: If you want smooth filter sweeps select 'OSC->TOOL->Apply Morph Sweep to

Wavetable'. Set the 'FADE' knob to 100. Then use WAVE to control the filter cutoff.
◦ Bandpass 2oct - A steppy spectral bandpass with two octaves bandwidth is
applied to the wavetable.
TIP: If you want smooth filter sweeps select 'OSC->TOOL->Apply Morph Sweep to

Wavetable'. Set the 'FADE' knob to 100. Then use WAVE to control the filter cutoff.
◦ Bandstop 1oct - A steppy spectral bandstop with over 120dB(!) and one octave
bandwidth is applied to the wavetable.
◦ Bandstop 2oct - A steppy spectral bandstop with over 120dB(!) and two octaves
bandwidth are applied to the wavetable.
46

◦ Sine Fade - Crossfades the waveform to a sine wave.
TIP: You can use this if a waveform doesn't have enough 'bottom' or doesn't sound

'warm' enough.
◦ F0 Cut Fade - Removes the first partial.
TIP: You can use this to make a waveform sound more bright.

◦ PW - Applies pulsewidth modulation to the oscillator. MORPH controls the
pulsewidth. When MORPH is set to 0 it will remove all even harmonics. As a result
a sawtooth will be turned into a square wave. When MORPH is set high values a
sawtooth will be turned into an impulse.
TIP: Select a sawtooth as waveform and set the LFO2 knob to 100 and MORPH to

0 for classic PWM.
◦ Comb 2x - Applies a comb filter with 2 stages to the oscillator.
TIP: Set the LFO2 knob to 100 and MORPH to 0 for beating strings.

◦ Comb 3x - Applies a comb filter with 3 stages to the oscillator.
TIP: Set the LFO2 knob to 100 and MORPH to 0 for beating strings.

◦ PhaseDist PW - Phase Distortion with pulsewidth control is applied to the oscillator.
Unlike the morphmode PW it does not change the waveform when MORPH is set
to 0.
TIP: Select a square wave as waveform and set the LFO2 knob to 100 and MORPH

to 0 for classic PWM.
◦ PhaseDist Saw - Classic Phase Distortion which is mostly known from the old
Casio synths. It morphs a sine wave to a sawtooth.
TIP: Select a sine wave as waveform and set the LFO2 knob to -100 and MORPH to

100 get the 'Casio CZ' sound.
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◦ PhaseDist Square - Classic Phase Distortion which morphs a sine wave to a
square wave.
TIP: Select a sine wave and set the LFO2 knob to -100, MORPH to 100.

◦ PhaseDist Double - Phase Distortion which morphs a waveform to a waveform
with double frequency.
◦ Mirror - Mirrors the waveform in the middle. When MORPH is set to 0 it will remove
all even harmonics. As a result your will get a hollow sound.
◦ Stack Octave+ - Stacks an oscillator and another one which is one octave higher.
MORPH controls the amount of phase shift between both oscillators.
TIP: Set the LFO2 knob to 100 and MORPH to 0 to get interesting sounds.

◦ Stack Octave- - Stacks an oscillator and another one which is one octave higher
and 180 degree phase shifted. MORPH controls the amount of phase shift between
both oscillators. When MORPH is set to 0 it will remove many even harmonics. As a
result this mode has a more hollow sound then 'Stack Octave+'.
TIP: Set the LFO2 knob to 100 and MORPH to 0 to get interesting sounds.

◦ Stack Harmonic + - Stacks an oscillator and another one which is two, three, four,
five, six, seven or eight times higher. MORPH controls the harmonic relationship
between both oscillators.
TIP: If you want smooth transitions select 'OSC->TOOL->Apply Morph Sweep to

Wavetable'. Set the 'FADE' knob to 100. Then use WAVE to morph the sound.
◦ Stack Harmonic - - Stacks a 180 degree phase shifted oscillator and another one
which is two, three, four, five, six, seven or eight times higher. MORPH controls the
harmonic relationship between both oscillators.
This mode has a more hollow sound then 'Stack Harmonic+'.
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◦ Stack Power - Stacks several oscillators which are two, three and four times
higher.
TIP: Use this mode together with sinoid waveforms to build organs.

◦ Chord 2x - Two stacked oscillators play a chord. The MORPH knob selects the
type of chord, like major, minor, fifth,...
◦ Chord 3x - Three stacked oscillators play a chord. The MORPH knob selects the
type of chord, like major, minor, fifth,...
◦ Interval – Shifts the base frequency of the oscillator. The MORPH knob selects the
harmonic relationship (1x-16x). This mode can be useful to build custom chords.
◦ Grunge - Adds additional harmonics to the oscillator.
TIP: If you want smooth transitions select 'OSC->TOOL->Apply Morph Sweep to

Wavetable'. Set the 'FADE' knob to 100. Then use WAVE to morph the sound.
◦ Jodel Chip - Plays a very fast arpeggiator to mimic a chord. This effect is known
from the chiptunes on vintage computers like the C64. MORPH controls the type of
chord. We called this mode 'Jodel' because Tone2 is a company from Bavaria.
TIP: Set the OCT knob to 0 or -1 to lower the speed of the chord.

◦ Noise White - Plays white noise.
◦ Noise Pink - Plays pink noise. Pink noise has more energy in the low spectrum.
◦ Noise Tuned - Plays noise, which base frequency follows the key that you currently
play.
TIP: This mode is very useful to build drum sounds. Select 'Aux1 Env' as matrix

source and select 'Pitch' as matrix target to build a snare drum.
TIP: Use this oscillator for the percussion of chiptunes.
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◦ Spirit - The pitch of the oscillators is frequency modulated with noise. This mode
gives a breathy sound. MORPH controls the amount of detuning.
TIP: Use this mode to build choirs and to make voices sound more natural.

◦ Analog - The oscillator sounds like an analog one. It has a muffled sound and
suffers from drift and saturation. MORPH controls the amount of distortion.
TIP: Select a sawtooth as waveform and use this mode together with the analog

filters for an authentic emulation of vintage synths.
◦ Low CPU - The oscillator is played back with a lower sample rate. As a result the
sound quality is reduced. It has a characteristic 'digital', but also interesting sound.
Morph controls the amount of undersampling.
TIP: This mode only need very low CPU. It can be used to reduce the CPU

requirements without much quality loss as long as you don't overdo it.
TIP: With high MORPH values this mode can be used to create droid-style

vocaloids.
◦ Aliasing - The oscillator is played back in an ugly way with a lower sample rate. As
a result the sound quality is reduced and disharmonic frequencies are added. It has
a characteristic 'cheap digital' sound. MOPRH controls the amount of
undersampling.
TIP: This mode can be used for effect sounds or if you want to mimic the sound of

cheap digital hardware.
◦ Vocoder - This mode is intended to be used together with wavetables created by
the vocoder. However it is not limited to this purpose and can give interesting
results with other wavetables. In this mode the sound will change in a way that the
frequency content sounds similar, no matter what key you press on the keyboard. It
does eliminate the 'mickey mouse effect' which is known when you you play back a
vocal sample with high pitch. It gives you independent control over pitch and
formant frequency. Low values of the MORPH knob shift the formant frequencies
down and result in a devil-like voice. High values shift the formant frequencies up
and give a smurf-like sound.
TIP: Select 'VOCODER->Easy create patch: Vocoder' and load a vocal sample and
to create a vocoder wavetable. Then use the MORPH knob to alter the sound.
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◦ Granulator - This mode can be used to pitchshift or to timestrech samples. This
mode is intended to be used together with wavetables created by the granulator in
the resynthesis section. However it is not limited to this purpose and can give
interesting results with other wavetables. The MORPH knob controls the pitch of
the sample which is played back.
TIP: Select 'RESYNTHESIS->Easy create patch: Granulator' and load a vocal

sample or a drum-line. Then use the MORPH knob to alter the pitch. Change the
Lfo1 SPEED for time freezing effects.
◦ One Shot - This mode play the waveform of the oscillator only for a single time. It is
useful to add transients to the attack sound of a patch. It can also be used to build
drum sets with short samples.
TIP: Icarus can handle very complex waveforms. It's even possible to load short

samples (less then 2048 samples samplelength) as a waveform to a wavetable.
Simply drag&drop a wav file to the 3D display of the oscillator. You can also use
'OSC->Tool->Load Waveform to current WAVE position'.
TIP: There is a 'Drumset' patch within the Templates directory which makes use of

these features.
TIP: We included several 'Drumset' wavetables to Icarus. Every waveform in these

wavetables contains a separate drum sample. The MORPH knob selects the
sample.
TIP: It's even possible to map different waveforms/samples to different keys on the

keyboard. Load a 'Drumset' as wavetable then select 'Key C C# D...' as matrix
source, select 'Wave 1' as matrix target and set 'matrix send' to 100.
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Oscillator controls
The three oscillators have the same general controls. They are:

•

Vol – This knob controls the volume of the oscillator.

•

Detune – This knob controls the amount of detuning applied to the oscillator.

•

Oct – knob control allows you to select the pitch octave at which the sample will be
played back, with a range of 8 octaves to choose from: 4 up for the positive values and
4 down for the negative values.

•

Wave – Runs through all waveforms in the wavetable.

•

Fade – When WAVE is modulated by LFO1 or another source the waveforms of the
wavetable are crossblended. The FADE knob controls how this crossblending is done.
If the knob is set to 0, the synthesizer will switch between the waveforms without any
crossblending. This gives a hard, clicking sound and reduces the CPU load. When
FADE to 100% the waveforms are smoothly crossfaded. A vale of 50% is a
combination of both. It can help to enhance the expression and clarity of the
wavetable.

•

Morph – The morph knob adjusts the way the selected morph mode affects the
wavetable. Morph modes are selected using the Morph mode menu (found just above
the morph knob) and are processed in realtime, this means that you hear all changes
immediately and you can route any modulation source to MORPH within the matrix.

•

Pan – The pan control allows you to position the sound in the stereo field (left-middleright)

•

Phase – The phase control changes the start phase of the oscillator's waveform.

•

Fine – This knob controls the fine tuning of the oscillator. The range is plus or minus
100 cents. There are 100 cents per semitone.
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•

LFO1 – The LFO1 knob is used to determine the amount of modulation LFO1 should
apply to the Wave control.

•

Punch button – Switches the oscillator punch mode to on/off, punch adds a kind of
artificial, zapping, percussive quality to the sound.

•

Keybutton – Switches the oscillator's keyfollow mode to on/off

•

LFO2 – The LFO2 knob is used to determine the amount of modulation LFO2 should
apply to the Morph control.

Saving CPU
If you don’t need an oscillator in a patch – turn it off. You will save CPU processing
power. The same goes for any filters you don’t need. If you don’t need it, turn it off!
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The Filter Section

The next stop on the audio route is the filter section.
Icarus has two identical filters, each with an excellent range of filter types to sculpt your
sound. These filter types range from traditional analog Low Pass, High Pass, Notch and
Bandpass filters, up to digital ones like Vocal, Phaser, Ringmod, Comb and Fractal filters.
A large number of these filter types are exclusive to Tone2 and not available in any other
product.
Filter types are selected by clicking on the filter name label (bottom left of the filter display, a
list will open from which you can select the filter type.
The filters can either be routed in parallel or in series. When routed in parallel the output from
each filter is independently sent to the next stage in the audio chain (the Insert Effect). In
serial mode, the output of Filter 1 is sent to the input of Filter 2. To switch between
parallel/series mode, click the Parallel button. When the button is in the ‘on’ position the filters
are in parallel, in the off position the filters are in series.
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Filter top menu

•

Tool – The tool button opens a menu with filter initialization option.
◦ Reset Filter1 – Resets Filter 1 to its default settings.
◦ Reset Filter2 - Resets Filter 2 to its default settings.
◦ Copy Filter1 to Filter2 – Copy Filter1's settings to Filter 2.
◦ Copy Filter2 to Filter1 - Copy Filter2's settings to Filter 2.
◦ Init Analog (use Filter2) – Initiates the filter's settings to those used in classic analog
hardware filters.
◦ Init Dual Formant Filter – Initiates both filters to a Dual Formant filter setup.

•

1 – Switches to Filter 1's display.

•

2 – Switches to Filter 2's display.

•

ON – Switches the filters to either on / off.
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Filter general controls

The controls are:
•

The Reso (resonance) control knob increasingly alters the characteristic of the filter
the more this value is increased. In traditional analog-style filters (low pass, high pass
and band pass filters), the RESO control makes the cut off point more pronounced by
increasing the volume of the CUTOFF frequency.

•

The Cutoff control knob changes the frequency at which the filter character changes
relative to the filter type.

•

The Env control knob determines how much influence the filter envelope has on the
Cutoff control and in which direction. Positive values over 0 will increase the filter cut
off value as the envelope outputs a positive value. Negative values under 0 will
decrease the cut off value as the envelope outputs a positive value.

•

The Vel control knob determines how much of the filter envelope is applied based on
velocity value.

•

The Drive control knob increases the amount of extra gain to the oscillator audio
signal before it enters the filters. This can drastically change the characteristics of the
filter. There are different drive 'models' that can be selected in the filter display:
◦ Distortion off – No drive is applied.
◦ Saturate - A distortion with very soft saturation. It has a warm and analog sound.
◦ Soft Clip - A distortion with soft clipping. It has a warm and analog sound.
◦ Hard Clip - A distortion with aggressive, hard clipping. It has a bright sound.
◦ Bitcrush - This is a bitcrusher effect which is modeled after old digital equipment
with a low bit rate. Think of the early digital samplers with 8-bit sound.
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◦ Warp - A distortion that sounds like a guitar amp.
◦ Waveshape - A waveshaper which adds an FM-type timbre to the audio.
◦ Ripple - A waveshaper which adds ripple to the signal. It has bright sound.
◦ Volume - Changes the volume of the filter output. This mode is useful to control the
balance, if you use two filters routed in parallel.

•

The Vel control determines how much influence velocity has on the CUTOFF control .
Positive values over 0 will increase the filter cut off value, negative values under 0 will
decrease the cut off value.

•

The Key knob is a bi-polar control that determines how the note played on the
keyboard affects the filter cut off frequency. At positive values above 0, higher note
values will increase the cut off frequency. At negative values below 0, higher note
values will decrease the cut off frequency.

•

The LFO3 control determines how much of LFO3's modulation should be applied to
the CUTOFF control .

The Filter and the Envelope
Remember that as you increase the Env control you’ll probably need to turn down the
Cutoff otherwise you won’t hear much of the envelope affecting the cut off. However,
you’ll need to increase the Cutoff if you want to use negative Env amounts

The Filter display
Each filter has it’s own filter display with the dual purpose of selecting parameters as well as
displaying the real time shaping of the filter as you alter the Cutoff and Reso parameters. The
horizontal axis show frequencies from lowest to highest, while the vertical axis represents the
gain. This gives you immediate visual feedback on your actions and helps you to learn about
the specifics of each of Icarus’ first class and versatile filters.
•

Filter Type Select
Click on the filter name to select a filter from the context menu.
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Here you have a selection of both classic analog-style as well as digital filters in low pass,
band pass and high pass and with multiple slopes – 12dB, 18dB and 24dB.
In addition to the analog filters, various EQ filters are available as well as the more unusual
filter types such as the Phaser, Combs, Vocal filter, etc.
About the basic filter types
In a Low Pass Filter (LPF), the Cutoff control will set the frequency at which the filter begins to
‘close’ and allow less and less of the higher frequencies through. When the frequencies are
high enough past the cut off point, no more sound will be allowed through the filter.
A High Pass Filter (HPF) allows high frequencies to be heard, but blocks the lower
frequencies. It is frequently used to create hi-pitched whistle sounds, and piercing synthesizer
leads.
A Band Pass Filter (BPF) allows the frequencies within a specific range to be heard, and
blocks out all the other frequencies above and below it. It can be used to create a variety of
effects, from the subtle to insane! Also, the filter’s slope is important. Basically, slope is the
amount of attenuation at certain frequencies. We usually discuss slope in terms of decibels
per octave.
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The lower the dB per octave, the more ‘gentle’ the filter sounds. e.g. a 12dB per octave filter
will remove 12dB of harmonics per octave above the filter cut off frequency.
Icarus also features a range of exotic filter types, like Vocal, Phaser, Resample, Ringmod, FM
and Fractal filters. Four special Resonator filter types to be used for Physical Modeling
purposes are also featured (Phys String, Phys Flute, Phys Odd & Phys Even)
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The Envelope Section
The envelope section has four envelopes which can be used to modify many of Icarus’
parameters. Two of the envelopes are ‘hard-wired’; the Volume Envelope is fixed to control
the Amplifier and the Filter Envelope controls the Filter.
The other two envelopes (Aux1 & Aux2) are not connected anywhere by default and can be
freely assigned using the Mod.Matrix.

Icarus’s envelope section has a display that shows the shape of the selected envelope,
The button controls are used to switch between the four different envelopes:

•

RET – Switches the envelope trigger mode to normal or special.

•

VOLUME – This selects the envelope that controls the current layer's volume.

•

FILTER – This button selects the envelope that controls the current layer's filter cut off.

•

AUX1 – This selects the Auxiliary 1 envelope which doesn't have a preset routing. It
can be routed to many destinations using the MOD MATRIX.

•

AUX2 – This selects the Auxiliary 2 envelope. Like AUX1, it doesn't have a preset
routing. It can be routed using the MOD MATRIX,

The knob controls are used for the main envelope controls:
•
•
•
•
•
•

A – This controls the Attack Time of the envelope.
H - This specifies the hold time of the envelope.
D – This controls the Decay Time of the envelope.
S – This sets the level of the Sustain section.
R – This sets the Release Time of the envelope.
SHAPE – This specifies the shape of the envelope curves. The values are from 0
which is a linear curve or pure straight line, up to 9 which is a logarithmic curve or a
curved line.
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TIP: Click inside the Envelope display to open a list of pre-set envelope shapes or to reset the

envelope to its default settings.

What is an Envelope?
An envelope generator allows a synthesizer to mimic acoustic instruments’
properties of changing volume and timbre over time. Traditionally, an envelope
generator produced a control voltage that varied over time which could be used to
automatically change the filter cut off or amplifier volume.
There are many different types of envelopes but the most common one is known as an ADSR
which is an acronym for Attack, Decay, Sustain and Release which describes the four controls
of the envelope. Another variant is the AHDSR which is an acronym for Attack, Hold, Decay,
Sustain and Release. The AHDSR is used in Electra2. A description of these are as follows:
Attack – Is a time value which states how long it takes for the envelope to go from zero to
maximum peak when a key is pressed.
Hold – Is a time value which states how long it takes for the envelope to wait at maximum
peak value.
Decay – is a time value which states how long it takes for the envelope to drop to the sustain
level.
Sustain – Is a level value which states the highest value while the key is being held down
after the Attack, Hold and Decay stages.
Release – Is a time value which states how long it takes for the the envelope to drop back
down to zero after the key has been released.
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LFO Section
LFO is an acronym for Low Frequency Oscillator. LFOs are oscillators that operate below the
threshold of human hearing (20 Hertz). They are used as modulators and are assigned in the
Mod Matrix.

Icarus has three identical LFOs and a Step LFO. The waveform display shows a visual
representation of the waveform. The Step LFO looks slightly different and will be explained
separately.
Choosing a shape for your LFO is
easy, right-click inside of the LFO
display and a list with predefined
shapes will open.
After selecting a shape it can be
further edited using the shape and
phase knobs.

•

LFO 1,2,3 Buttons – The buttons select which one of the three LFOs is selected for
editing.

•

STEP Button – This button selects the Step LFO.

•

SPEED – This knob controls the speed of the LFO. The range depends on the LFO
Mode:
◦ In BPM Mode – The range will be shown as a multiple of the host's tempo. e.g. 1/2
BPM is half of your host's tempo, 4 BPM is four times your host's tempo.
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◦ In non-BPM Mode – The range will be shown in Hertz (Hz). The range is 0.02 Hz
to 440.1 Hz

•

Mono button – Switches the LFO into Mono Mode.

•

ENV button – Switches the LFO OneShot Envelope Mode on/off.

•

Shape – Adjusts the current LFO shape.

•

Key – Sets the amount of key follow to use for this LFO.

•

Phase – This will adjust the starting position of the LFO's waveform.

•

Fade in – This control adds a fade-in to the LFO.

The Step LFO
The Step LFO uses a Multi-Stage Envelope in which you can set up your own shape by
dragging envelope points. Simply left-click on one of its points and drag it to the desired
location.

Like LFOs, a step LFO doesn’t produce any sound in itself, a step LFO is used to modulate
another sound parameter to achieve cyclic modulations (changes) of this parameter over
time, according to the Speed knob settings.
Please note that the step LFO is always synced to your host’s tempo.
Available controls are:
•

SPEED – This knob controls the speed of the step LFO. The range depends on the
LFO Mode:
◦ In BPM Mode – The range will be shown as a multiple of the host's tempo. e.g. 1/2
BPM is half of your host's tempo, 4 BPM is four times your host's tempo.
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◦ In non-BPM Mode – The range will be shown in Hertz (Hz). The range is 0.02 Hz
to 440.1 Hz
•

Mono button – Switches the step LFO into Mono Mode.

•

ENV button – Switches the step LFO OneShot Envelope Mode on/off.

•

Shape – Adjusts the current step LFO shape.

•

Key – Sets the amount of keyfollow to use for the step LFO.

•

Phase – This will adjust the starting position of the step LFO's waveform.

•

Fade in – This will apply a fade-in to the step LFO.
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The Arpeggiator Section

Almost a synth by itself, the arpeggiator section holds the key to all of your arpeggio needs. It
offers a way to set up your own arpeggios that is both powerful and easy to work with.
We developed smart algorithms which return melodies that are more useful musically than
conventional arpeggiators.
Working with the arpeggiator is extremely simple. Just lay down your notes inside the note
sequencer as you normally would and select the play direction. The arpeggiator also supports
optional advanced features such as autochords, polyphonic playback, pitch slides, legato,
swing-shuffle, split, matrix integration and it gives you very precise control over note-sorting,
play direction and velocity.
Don’t feel like programming your own patterns? Use one of the built-in patterns or load one of
the many external pattern presets to use as a starting point.
Top menu
•

Tool Menu
◦ Load – Loads an arpeggiator pattern from disk.
◦ Save – Saves your arpeggiator pattern to disk.
◦ Reset – Resets the arpeggiator pattern to its default values.
◦ Set direction …. – Sets the arpeggiator mode.
◦ Arpeggiator preset list – Displays a list of available arp presets (found inside of the
“Icarus_arps” folder.

•

ON button – Turns the arpeggiator on / off.
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Bottom menu

◦ Speed menu – The speed menu is used to set the arpeggiator’s tempo (in CLK)
◦ Loop menu – The loop menu is used to control the amount of steps the arpeggiator
should run, or on which step it should stop.
◦ Octave / Chord menu - The arpeggiator supports playback over several octaves as
well as automatic chords.
To make the arpeggiator play over several octaves click on 'Octaves off' and select
2,3,4 or 5 octaves instead. When you select '3 Octaves' it will play C2 C3 C4 as
soon as you press the C key. The 'Chord', '5th', and 'Third' modes automatically
create chords when you press a single key. You can combine all 'Octave' and
'Chord' modes with the 'Stack' Arpeggiator mode. In Stack mode a whole stacked
major or minor chord will be triggered when you hit a single key. It is released when
you release the key. Make sure that you don't forget to switch to 'Polyphonic' in
Icarus' Setup panel.
◦ Play mode menu – Switches the arpeggiator to a specific play mode. The following
modes are available:
Default – uses the default play mode
Split High / Low - Switches the arpeggiator to keyboard split mode. Low keys will
use the arp to playback and higher keys will play normally.
Stack Chord - This mode works together with the Chord option found in the arp
menu. It uses the selected chord and lets you play that chord using a single key.
Note that all arpeggiator options (note sorting, octave, semi,....) will be ignored in
this mode.
Dual Layer – Switches the arpeggiator to Dual Layer mode. In Dual Layer mode
OSC1 plays the arpeggio while OSC2 plays a chord without the arp. You can set
this up using the Keysplit High/Low routed to Osc volumes inside of the Modulation
Matrix.
◦ Swing / Shuffle menu - The Swing / Shuffle menu allows you to add swing or shuffle
to your arp pattern. Its default setting is straight – when click-held & dragged up
shuffle is increased, when click-held & dragged down the amount of swing is
increased.
Straight: When set to its middle position: Straight, all step events are aligned
straight to the tempo grid.
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Swing: When set to a lower position: Swing lets you create various ‘swing’ effects.
By increasing the amount of swing, step events will have a greater swing groove.
Shuffle: When set to a higher position: Shuffle has a specific 8th note rhythmic feel.
It is based on triplet subdivisions of the beat rather than on dividing each beat
perfectly in half (a.k.a. straight 8th notes).

The Pattern sequencer
The Pattern sequencer is where all the action happens. Here you will tell the arpeggiator
which pattern to follow and set up which notes it should use.
The pattern sequencer is represented by a grid of 32 steps. The horizontal line represents the
arp sequencer step number, the vertical line is used to set which octave / semi note that step
should use.
To switch a step on/off click on one of the steps. Whenever a step is switched on, it will play
back a note. When a step is switched off, the last active note will be held until the next active
step.
To set which octave a step should use, click within the 4 octave vertical range of the step. To
select semi notes, click-hold & drag the step up or down.
Note that Icarus' value readout display (found below the Patch display, will show you which
Octave / Semi note value is selected.
Note sorting / Play direction / Chord and special commands
The 'Arp Order' row is located below the sequencer note grid. This row gives detailed control
on how the arpeggiator handles the incoming notes.
The 'Arp order' command always refers to the current arpeggiator slot.
■ Play direction commands
+ (up: CEG CEG) - Sets the play direction of the current slot to 'up'. When you play a chord
with three notes (C E G) it will start with the lowest note C. After that it will continue with the
middle note E. As soon as the highest G has been played it will restart with the lowest note C.
You can set the
play direction of all 16 slots to + by selecting 'Load' -> 'Set direction up'.
- (down: GEC GEC) - Sets the play direction of the current slot to 'down'. When you play a
chord with three notes (C E G) it will start with the highest note G. After that it will continue
with the middle note E. As soon as the lowest note C has been played it will restart with the
highest note G. You can set
the play direction of all 16 slots to - by selecting 'Load' ->
'Set direction down'.
+- (alt up: CEGE CEGE) - Sets the play direction of the current slot to 'alternate up and
down'. When you play a chord with three notes (C E G) it will start with the lowest note C
and go 'up'. After that it will continue with the middle note E. When the highest note G is
played it will change the direction to 'down' and the middle note E will follow. When the lowest
note C is reached it changes the direction to 'up' again. You can set the play direction of all 16
slots to +- by selecting 'Load' -> 'Set direction alt up'.
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-+ (alt down: GECE GECE) - Sets the play direction of the current slot to 'alternate down and
up'. When you play a chord with three notes (C E G) it will start with the highest note G and
go 'down'. After that it will continue with the middle note E. When the lowest note C is played it
will change the direction to 'up' and the middle note E will follow. When the highest note G is
reached it changes the direction to 'down' again. You can set the play direction of all 16 slots
to -+ by selecting 'Load' -> 'Set direction alt down'.
++ (two up) - Like +, but instead of one it goes two notes up.
– (two down) - Like -, but instead of one it goes two notes down.
. (same note again) - Repeats the note played in the previous slot.
? (random) - Plays a random note
+! (classic up: CEG CEG) - Like +, but without the 'smart melody' algorithm. In this mode
the arpeggiator behaves as in
conventional synthesizers. The (mostly uncomfortable)
effect is most obvious when you set 'Arp Note semi' in the grid to various values. You can set
the play direction of all 16 slots to +! by selecting 'Load' -> 'Set direction classic up'.
-! (classic down: GEC GEC) - Like -, but without the 'smart melody' algorithm. In this mode
the arpeggiator behaves as in conventional synthesizers. The (mostly uncomfortable) effect is
most obvious when you set 'Arp Note semi' in the grid to various values. You can set the play
direction of all 16 slots to -! by selecting 'Load' -> 'Set direction classic down'.
Chord commands
2 (chord with 2 notes) - Plays a chord with two notes.
+2 (Go up and play a chord with 2 notes) - Like + followed by 2
-2 (Go down and play a chord with 2 notes) - Like - followed by 2.
3 (chord with 3 notes) - Plays a chord with three notes
+3 (Go up and play a chord with 3 notes) - Like + followed by 3
-3 (Go down and play a chord with 3 notes) - Like - followed by 3
All (Play a chord with all notes) - Plays a chord containing all keys that are currently pressed.
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Special commands
SL (start with the lowest note) - Forces a resorting of the notes and the lowest note is played.
It can be musically useful to place this command in slot 0 or slots that you want to attenuate.
As a result the melody created by the arpeggiator appears less 'chaotic'.
SH (start with the highest note) - Forces a resorting of the notes and the highest note is
played. It can be musically useful to place this command in slot 0 or slots that you want to
attenuate. As a result the melody created by the arpeggiator appears less 'chaotic'.
R (release) - Triggers the envelope's release phase.
L (loop-length) - If you set slot 6 to L the Arpeggiator will restart the loop sequence after 6
bars, instead of 16 bars.
E (end) - If you set slot 6 to E the Arpeggiator will stop playing at slot 6.
■ Pitch glide and legato commands
< (legato) - When the < is placed in a slot the arpeggiator does not trigger a new note.
Instead of this it glides from the currently played note to the new one. This command only
applies if the current and the last note are different. So a combination with 'Arp note' set to
one of octave higher/lower is useful in most cases.
/X (glide X halftones up) - This glide behaves like you would be moving your pitchwheel up. It
raises the pitch for X halftones till the next slot. It does not care about the previously or
currently played note like the legato.
\X (glide X halftones down) - This glide behaves like you would be moving your pitchwheel
down. It lowers the pitch for X halftones till the next slot. It does not care about the previously
or currently played note like the legato.
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The Mod Matrix Section
The Mod. Matrix or MODulation Matrix is a system that allows you to flexibly assign different
modulators (such as LFOs or envelopes) to different destinations (such as the filter, amplifier
or even other modulators).

Icarus’ modulation Matrix has 18 slots to allow you to make 18 modulation assignments. The
procedure for assigning modulation is very simple:
1. Choose a modulator (modulation source) in the drop-down menu. This is what causes
the modulation or changing effect.
2. Choose a target (destination) in the drop-down menu. This is what gets affected by the
modulation or changing effect.
3. Specify an amount other than Zero by clicking and dragging the Modulation Amount
value. This is how much modulation gets sent to the destination. The lower the value
the more subtle the effect.
The controls for the modulation Matrix are:
•

Tool – The INIT button opens a menu with Modulation Reset / Clean options.
◦ Reset Matrix – Resets all modulation matrix slots to their default values.
◦ Clean Matrix – Removes all non-routed / non-active mod.matrix slots

•

Modulation Slot Selection Buttons A, B and C – There are 18 modulation slots
overall arranged in three pages of six. Click on button A, B or C to access these slots
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•

Modulation Source Selector Menu – If you left-click on one of the modulation source
areas on the Matrix display, a selector menu appears. The menu options are:
◦ Off – No modulation source selected. This is the default selection.
◦ Vol Env – This selects the Volume Envelope as the modulation source. Although
the Vol Env is hard-wired to the amplifier, it can also be used to modulate another
destination at the same time.
◦ Filt Env – This selects the Filter Envelope as the modulation source. Although the
Filt Env is hard-wired to the Filter, it can also be used to modulate another
destination at the same time.
◦ Aux1 Env, Aux2 Env – These select the Auxiliary Envelopes 1 or 2 as the
modulation source. Unlike the Vol Env and the Filt Env the Auxiliary Envelopes are
not hard-wired to anything so they must be routed in the Mod Matrix for their effect
to be heard.
◦ LFO1+ – LFO1 in unipolar mode as modulation source, only uses LFO1's positive
values.
◦ LFO1+- – LFO1 in bipolar mode as modulation source, this uses LFO1's negative
and positive values.
◦ LFO2+ – LFO1 in unipolar mode as modulation source, only uses LFO1's positive
values.
◦ LFO2+- – LFO2 in bipolar mode as modulation source, this uses LFO1's negative
and positive values.
◦ LFO3+ – LFO1 in unipolar mode as modulation source, only uses LFO1's positive
values.
◦ LFO3+- – LFO2 in bipolar mode as modulation source, this uses LFO1's negative
and positive values.
◦ Step+ – Applies the arp's velocity steps as modulation source using only positive
values.
◦ Step+- – Applies the arp's velocity steps as modulation source using both positive
and negative values.
◦ Const – This option uses a static value as the modulation source. The value is
taken from the Modulation Amount parameter. This option is useful if you need a
parameter offset to any modulation destination.
71

◦ Random – This option selects a new random value when a key is pressed on your
keyboard controller. Note that the value will be static until you play a new note when
a new random value will be created.
◦ Flipflop - This option 'flips' between two values. The value is determined by the
Modulation Amount. e.g. a Modulation Amount of 10 would 'flip' between +10 and
-10. However, the parameter that is going to be modulated acts as a value offset.
◦ White Noise – This option generates white noise. This is a continuously varying
random value.
◦ Pink Noise – This option generates pink noise. This is a continuously varying
random value.
◦ Key – This will use the note value of the key you play on your keyboard controller
as a modulation source. A low note will generate a low number, a high note will
generate a high number.
◦ Velocity+ – Uses the positive Velocity values to modulate
◦ Velocity+ - – Uses both the positive and negative Velocity values to modulate.
◦ Modwheel – This will use the modulation wheel from your keyboard controller as a
modulation source. Note that you will only change the value if you move the
modwheel, otherwise the value will be static (which will be the last value transmitted
by the modwheel).
◦ Pitchwheel – This will use the pitchwheel from your keyboard controller as a
modulation source.
◦ Aftertouch. - This will use the aftertouch messages from your keyboard controller
as a modulation source. Please check the operating instructions of your keyboard
controller to see if it generates aftertouch information. Not all keyboard controllers
do.
◦ Breath - Responds to Breath controller as modulation.
◦ Foot - Responds to Foot switch controller as modulation source.
◦ MainVol - Responds to Main Volume controller (CC#7) as modulation source.
◦ Expression. - Responds to Expression controller (CC#11) as modulation source.
◦ Hold - Responds to Hold pedal (sustain) on/off (CC#69) as modulation source.
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◦ CC16-CC19 - Responds to CC#16 to CC#19 (continuous controllers) as modulation
source.
◦ Key Pressed - Applies a On/Off Gate modulation; i.e, on key press its value is 1,
on release it's 0.
◦ Key Pressed- - Applies a Off/On Gate modulation; i.e, on key press its value is 0,
on release its 1.
◦ Key split high - Assigns the high keys of a keysplit to be used as modulation
source.
◦ Key split low - Assigns the low keys of a keysplit to be used as modulation source.
◦ Impulse - A short impulse is used as modulation source; could for example be
applied to sharpen the attack portion of a sound.
◦ Decay8ms-16s - Decay will use an internal envelope to modulate, options are
envelopes that run from 4 milliseconds to 16 seconds.
◦ Sine1/64Hz – Sine16Hz - Uses a sine shape as modulation source, the amount of
Hz denotes the modulation speed used.
◦ X*X - Uses the X multiplied by X value modifier as modulation source.
◦ Sqrt (X) - Uses Squareroot X value modifier as modulation source.
Filter
◦ Filter (X) - Uses the filter X value modifier as modulation source.
◦ Limit (X) - Uses the Limit X value modifier as modulation source.
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•

Destination Selection Menu - If you left-click on one of the destination areas on the
Matrix display, a selector menu appears. The menu options are:
◦ Off - No modulation destination selected. This is the default selection.
◦ Volume – The volume of the current layer.
◦ Pan – Selects the Master Panning control .
◦ Octave – Selects the Master Octave .
◦ Semi – Selects the Master Semitone setting .
◦ Pitch XL – Selects the Master Pitch XL.
◦ Pitch – Selects the Master Pitch.
◦ Fine – Selects the Master Fine control .
◦ Cutoff 1 – Selects the Filter Cut Off setting of Filter 1.
◦ Cutoff 2 – Selects the Filter Cut Off setting of Filter 2..
◦ Reso 1 – Selects the Filter Resonance setting of Filter 1.
◦ Reso 2 – Selects the Filter Resonance setting of Filter 2.
◦ Drive 1 – Selects the Filter Drive setting of Filter 1.
◦ Drive 2 – Selects the Filter Drive setting of Filter 2.
◦ Wave 1 – Selects the Wave setting of Oscillator 1.
◦ Wave 2 – Selects the Wave setting of Oscillator 2.
◦ Wave 3 – Selects the Wave setting of Oscillator 3.
◦ Morph 1 – Selects the Morph setting of Oscillator 1.
◦ Morph 2 – Selects the Morph setting of Oscillator 2.
◦ Morph 3 – Selects the Morph setting of Oscillator 3.
◦ Volume 1 – Selects the Volume setting of Oscillator 1.
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◦ Volume 2 – Selects the Volume setting of Oscillator 2.
◦ Volume 3 – Selects the Volume setting of Oscillator 3.
◦ Pan 1 – Selects the Pan setting of Oscillator 1.
◦ Pan 2 – Selects the Pan setting of Oscillator 2.
◦ Pan 3 – Selects the Pan setting of Oscillator 3.
◦ Octave 1 – Selects the Octave setting of Oscillator 1n.
◦ Octave 2 – Selects the Octave setting of Oscillator 2.
◦ Octave 3 – Selects the Octave setting of Oscillator 3.
◦ Interval 1 – Selects the Interval setting of Oscillator 1.
◦ Interval 2 – Selects the Interval setting of Oscillator 2.
◦ Interval 3 – Selects the Interval setting of Oscillator 3.
◦ Semi 1 – Selects the Semitone setting of Oscillator 1.
◦ Semi 2 – Selects the Semitone setting of Oscillator 2.
◦ Semi 3 – Selects the Semitone setting of Oscillator 1.
◦ Pitch XL 1 – Selects the Pitch XL control setting of Oscillator 1.
◦ Pitch XL 2 – Selects the Pitch XL control setting of Oscillator 2.
◦ Pitch XL 3 – Selects the Pitch XL control setting of Oscillator 3.
◦ Pitch 1 – Selects the Pitch control setting of Oscillator 1.
◦ Pitch 2 – Selects the Pitch control setting of Oscillator 2.
◦ Pitch 3 – Selects the Pitch control setting of Oscillator 3.
◦ Fine 1 – Selects the Fine Tune setting of Oscillator 1.
◦ Fine 2– Selects the Fine Tune setting of Oscillator 2.
◦ Fine 3 – Selects the Fine Tune setting of Oscillator 3.
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◦ Pitch1,2,3 – Selects the Pitch control setting of Oscillator 1, 2, or 3.
◦ Detune 1 – Selects the Detune setting of Oscillator 1.
◦ Detune 2 – Selects the Detune setting of Oscillator 2.
◦ Detune 3 – Selects the Detune setting of Oscillator 3.
◦ LFO1 Speed – Selects the Speed setting of LFO 1.
◦ LFO2 Speed – Selects the Speed setting of LFO 2.
◦ LFO3 Speed – Selects the Speed setting of LFO 3.
◦ Vol A,H, D,S,R – Selects the Volume Envelope's Attack, Hold, Decay, Sustain or
Release parameters.
◦ Filter A,H,D,S,R – Selects the Filter Envelope's Attack, Hold, Decay, Sustain or
Release parameters.
◦ Aux1 A,H,D,S,R – Selects the Auxiliary 1 Envelope's Attack, Hold, Decay, Sustain
or Release parameters.
◦ Env1 S – Selects the Envelope's Shape setting.
◦ Env1 R – Selects the Envelope's Retrigger setting.
◦ X:=Value – Selects the X:=Value destination.
◦ Matrix 1-18– Selects the Modulation Amount setting of Modulation Matrix slot 1-18
◦ EQ low – Selects the EQ Low as destination.
◦ EQ high – Selects the EQ High as destination.
◦ EQ mid – Selects the EQ Mid as destination.
◦ EQ mid Freq – Selects the EQ Mid Freq as destination.
◦ Fx1 Mix – Selects the FX1 Mix control as destination.
◦ Fx1 Par1 – Selects the FX1 Parameter 1 control as destination.
◦ Fx1 Par2 – Selects the FX1 Parameter 2 control as destination.
◦ Fx1 Par3 – Selects the FX1 Parameter 3 control as destination.
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◦ Fx1 Par4 – Selects the FX1 Parameter 4 control as destination.
◦ Fx2 Mix – Selects the FX2 Mix control as destination.
◦ Fx2 Par1 – Selects the FX2 Parameter 1 control as destination.
◦ Fx2 Par2 – Selects the FX2 Parameter 2 control as destination.
◦ Fx2 Par3 – Selects the FX2 Parameter 3 control as destination.
◦ Fx2 Par4 – Selects the FX2 Parameter 4 control as destination.
◦ Fx3 Mix – Selects the FX3 Mix control as destination.
◦ Fx3 Par1 – Selects the FX3 Parameter 1 control as destination.
◦ Fx3 Par2 – Selects the FX3 Parameter 2 control as destination.
◦ Fx3 Par3 – Selects the FX3 Parameter 3 control as destination.
◦ Fx3 Par4 – Selects the FX3 Parameter 4 control as destination.
◦ Feedback – Selects the Feedback control as destination.
◦ Effect Mix – Selects the Effect Mix control as destination.
•

Modulation Amount – This is a bipolar control that ranges from -100 to 100. Click and
drag the amount to change it. A positive number will give positive modulation and a
negative number will give negative modulation.

Modulation Tips
You can use Modulation Amount as a destination if you wish to use one modulation
source to control the amount of modulation of a parameter. e.g. Use the Modwheel
to control the amount of
vibrato:
Note that the Modulation Amount for
Slot1 is 0. This value is modulated by
the Modwheel, which is assigned in
Slot2.
Negative Modulation Amount values
are useful if you wish to reduce the
value of a parameter with positive modulation. e.g. You can lower the filter cutoff when you
use the Modwheel.
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The Setup Section

The setup section in Icarus covers the general performance settings.
Setup options available are:
•

Play Mode – The play mode sets the polyphony of the layer and how Electra2 reacts
to you playing your keyboard controller:
◦ Monophonic – This mode sets the polyphony to 1 note (monophonic) which
mimics the way the classic analogue synthesizers of the past behaved.
◦ Legato new – The punchy sounding Legato new is suitable for modern music.
When you play a key, no gliding will occur – the oscillators will immediately play the
new note. As soon as you release the second key the oscillators will glide. The
glide knob controls the glide speed of the oscillators. If you set the RET (Retrigger) option for Env1 or Env2 to off, the Envelope will also be re-triggered when
you release a key.
◦ Legato Classic – This is a classic Legato. When you play the first key no gliding
will occur. As soon as you press another key the oscillators will glide. The glide
knob controls the glide speed of the oscillators. If you set the RET (Re-trigger)
option for Env1 or Env2 to off, the Envelope is re-triggered as soon as you play
another key.
◦ Polyphonic 1-64 – These are Polyphonic play-modes similar to what you know
from conventional synthesizers. The number represents the number of voices that
are available. When this limit is reached the engine softly fades out voices without
any clicks. If you use unison (2X or 4X), the number of voices is automatically
multiplied by 2 or 4. In this way voice management is taken care of for you
automatically. In most cases 6 or 8 voices will suffice. If you notice that the CPU
usage is too high you can reduce the number of voices or switch off the unison.
The glide knob controls the glide speed of the oscillators. In Polyphonic mode
polyphonic gliding is supported. Gliding always occurs if the glide knob is set to a
value larger than 0.
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•

Glide Mode - This manages the glide mode options. The glide knob found inside the
Sound Section controls the glide speed of the oscillators. Gliding occurs if you set the
glide knob to a value larger than 0. Inside the Glide Mode menu you can select from
one of the several Glide modes that Icarus offers:
◦ Modern glide – A linear pitch sweep between notes. In most cases this will be the
most musically useful sounding mode.
◦ Vintage glide – A logarithmic pitch sweep between notes which sounds more like
'analog' synthesizers. This mode lowpass filters the pitch of the oscillators. As a
result you get faster gliding at the beginning and slower gliding when the target
pitch is reached.
◦ Variable glide – The speed of the glide depends on how far the distance between
the two notes is. A glide over several octaves will take longer than gliding to a
neighboring note.

•

Pitchwheel - This controls the Pitchwheel options.
◦ Off – Switches the Pitchwheel off.
◦ Pitchwheel +-1 / +-48 – Switches the range of the Pitchwheel to a value of +-1 up
to a range of +-48.

•

Punch Mode settings - The punch modes add a kind of artificial, zapping, percussive
and chirping quality to the sound. It's most obvious when you play a saw wave at low
frequency, or if you are using volume envelopes with short decay and release times.

•

Arp/LFO sync – This controls the Arp/LFO synchronization settings.
◦ Arp/LFO Hardsync – Uses Hard Sync mode for the arpeggiator & LFO.
◦ Arp/LFO Free – Uses Free Running mode for the arpeggiator & LFO.
◦ Arp/LFO Softsync – Uses Soft Sync mode for the arpeggiator & LFO.

•

Micro-tuning Modes – Icarus probably comes with the most advanced microtuning
section, which is currently available on the market.
Microtuning is a subtle effect which enhances chords. It does not have an effect on
mono or legato sounds. When microtuning is active, certain notes are slightly pitched
up or down to achieve a more harmonic sounding chord.
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Piano tuners and organists did experiment for more than one hundred years to find
good settings. We have analyzed and enhanced their results further.
With classic instruments like organs it is not possible to change the tuning of the
voices during playback, however this is possible in Icarus. The 'Dynamic' modes
analyze your chords in realtime and detune the voices in a subtle way.
How is the difference audible?
The most easy way to hear the difference is that you initialize a patch which uses only
a single sawtooth. Select 'FILE->Init patch' and click on 'SETUP'. The default patch
already is initialized with the 'Dynamic Silky' as microtuning mode.
Press two keys on the keyboard and play a minor third (3 halftones) and mayor third
(4 halftones) as chord. You will hear a beating with slow modulation. Now press two
keys on the keyboard an play an octave (12 halftones). Again you will hear a beating
with a very slow modulation.
Now switch off the microtuning by selecting 'Standard tuning', which is used by
conventional synthesizers. Press two keys on the keyboard and play a minor third (3
halftones) and mayor third (4 halftones) as chord. You will hear more disharmonic
sound with a very fast beating. Now press two keys on the keyboard and play an
octave (12 halftones). You will hear a static and thin sound with no modulation at all.
The following Microtuning modes are available:
◦ Standard Tuning – No microtuning is used. This mode is used by most
conventional synthesizers. Use this mode for monophonic and legato sounds.
◦ Dynamic Thirds – A subtle improvement of the standard tuning. Minor thirds (3
halftones) and mayor thirds (4 halftones) are slightly enhanced.
◦ Dynamic Thirds+ – An improvement of the standard tuning. Minor thirds (3
halftones) and mayor thirds (4 halftones) are moderately enhanced.
◦ Dynamic Just – Minor thirds (3 halftones), mayor thirds (4 halftones) and fifths (7
halftones) are heavily processed. The frequency of the beating is minimized. This
mode is extreme and can sound 'out of tune', but it can be useful for organs.
◦ Dynamic Silky – Minor thirds (3 halftones), mayor thirds (4 halftones) and
octaves (12 halftones) are moderately enhanced. This mode has a warm an silky
sound with a slower beating and is a great choice for chords and sounds with
slightly detuned oscillators. This innovative mode is exclusive and not available in
other synthesizers.
◦ Dynamic Valotti – We extended the famous Valotti tuning with dynamic octave
spreading. This mode has a very lively sound. The beating speed of chords varies.
It is a good choice for sounds with moderately detuned oscillators and for analog
emulation. This mode is exclusive and not available in other synthesizers.
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◦ Dynamic Subtle – Like 'Dynamic Silky' but with less extreme settings.
◦ Dynamic Octaves – Standard tuning with dynamic octave spreading. Thirds and
Fifths are not affected.
◦ Valotti – The classic Valotti tuning one of the most popular modes for classic music
and organs. This mode has a lively sound. The beating speed of chords varies.
◦ Valotti Fat – We extended classic Valotti tuning with a subtle octave spreading.
Maybe someone else already did this before.
◦ Young – The Young tuning is quite popular.
◦ Werckmeister 3 – Many Organists prefer Werkmeister 3. It is popular for classic
music.
◦ Young-Sorge, Kirnberger 3,Neidhardt & Hammer – These historical modes are
well known. We think that Valotti and Werkmeister 3 sound better, but feel free to
use them if you like them. There are a lot more microtuning modes and variations
out there, but we think that quality is more important than quantity.
◦ Sinus 7cent, 5cent– These modes are not well known, but we think that they
sound good and really deserve to get some attention. They sound similar to Valotti.
◦ Stretch Light – Standard tuning with subtle octave stretching. Some pianos are
tuned this way.
◦ Stretch Medium – Standard tuning with octave stretching. Many pianos are tuned
this way.
◦ Stretch Heavy – Standard tuning with heavy octave stretching.
◦ Stretch Valotti – Valotti tuning with octave spreading. If we would own a real grand
piano we'd tune it this way.
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The FX Section
The effects section consists of three effect slots. No less than 53 effects are available from
the effects section, ranging from Reverb, Delay, Chorus, and Phaser, to Tremelo, Vibrato,
Distortion, Amp-Simulation, Multiband Distortion, Bitcrush, Degrader and Compressor.

Click on the Effect Type Select parameter to open a context list of available effects types.
Once you have selected an effect, the available parameters will update accordingly inside the
FX Display window. The parameters can be changed by click-and-holding your left mouse
button and dragging your mouse up or down.
FX Menu controls

•

Tool– The tool menu offers several effect related load/save/reset options. Options
available are:
◦ Reset Effects – Resets all effect slots to their default settings.
◦ Load Effect Template – Loads an effect template from disk.
◦ Save Effect Template – Saves an effect template to disk.
◦ FX Template list – This list contains an overview of the templates available from
Icarus' 'Icarus_effects' folder.
82

•

1 – Switches to the FX1 slot display.

•

2 – Switches to the FX2 slot display.

•

3 – Switches to the FX3 slot display.

•

FEEDB – Switches to the Feedback display. The Feedback feature allows you to
control the amount of signal fed back into the FX's input.

•

ROUTE – Switches to the FX Routing display. Inside the Routing tab you'll find several
options having to do with how the effects are routed or applied to the signal. The
routing menu offers the following options:

◦ FX1->FX2->FX3 - Serial mode: The dry output of the synthesizer is sent to FX1.
Mix1 controls the dry/wet mix of FX1. The mixed signal is sent to FX2. Mix2
controls the dry/wet mix of FX2. The mixed signal is sent to FX3. Mix3 control the
dry/wet mix of FX3.
◦ (FX1+FX2)->FX3 - Parallel mode: The dry output of the synthesizer is sent to FX1.
Mix1 controls the dry/wet mix of FX1. The dry output of the synthesizer is also sent
to FX2. Mix2 controls the dry/wet mix of FX2.
Both mixed signals are summed and sent to FX3. Mix3 control the dry/wet mix of
FX3.
◦ (Left->FX1 + Right->FX2)->FX3: In this mode the synth's left dry signal is send into
FX1, the synth's right dry signal is sent into FX2.
Both mixed signals are summed and sent to FX3. Mix3 control the dry/wet mix of
FX3.
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TIP: This mode can be used to assign two different effects to two different

oscillators. First select two different effects for FX1 and FX2, for example a reverb
and chorus. Then set the PAN knob of OSC1 to -100 to pan it left and set the PAN
knob of OSC2 to +100 to pan it right. Now OSC1 will be processed with a reverb
and OSC2 will be processed with a chorus.

•

ON – Switches the FX to either on / off.

FX General controls
•

The MIX 1,2,3 knob controls the wet/dry balance of the FX1, FX2 & FX3 effect slots.

•

The Duck knobs provide a Ducking mode control that help make the mix sound more
transparent.
Especially with long Reverbs and Delays you frequently face the problem that a part of
the delay tail overlaps with a currently played note. As a result it either 'messes up the
mix' with 'too much effect mix' or the delay effect is nearly inaudible, because the mix
level had to be reduced a lot.
To solve this problem we introduced a ducking feature which allows a higher effect mix
without making the synth sound 'over effected'.

•

Pan – Controls the amount of panning applied.

Effect list
◦ Reverb Medium - Simulates a medium room with lots of diffusion.
◦ Reverb Big - Simulates a huge room with lots of diffusion.
◦ Reverb Plate – Simulates a plate reverb, which uses an electromechanical
transducer to create vibration in a large plate of sheet metal.
◦ Reverb Glass - Simulates a bright room which absorbs low frequencies.
◦ Reverb Dark – A darker type of reverb.
◦ Reverb Infinite - A reverb with an infinitely long reverb tail (great for Pads, FX and
Ambient tracks)
◦ Reverb Feedback - A reverb with feedback. which has a metallic sound.
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◦ Reverb Spring – Simulates a hardware spring reverb system, which uses a
transducer at one end of a spring and a pickup at the other, similar to those used in
plate reverbs
◦ Reverb Trance – A reverb specifically tailored for Trance based music styles.
◦ Reverb Cheap – A cheap type reverb sound like those found in cheaper or older
hardware FX units.
◦ Reflections - When size is set to 0 it can be used to simulate early reflections,
larger values sound like a chaotic echo.
◦ Delay - Stereo delay synced to your host's tempo.
◦ Pingpong – A tempo synced delay which alternatively pans from left to right.
◦ Multitap - Very powerful multistage delay with rhythmic beats. Also includes a
number of pingpong types and a reverse delay mode.
◦ Delay Fat - A fat sounding delay with detuning. In this mode the mix knob controls
the amount of feedback.
◦ Delay Dual - A double delay. Delay times for the left and right channel can be
changed individually.
◦ Delay Diffuse - A fat sounding delay with diffusion and detuning. It has a silky
sound.
◦ Delay Band - Filtered stereo delay synced to your host's tempo. The frequency
bandwidth gets more and more narrow over time. Useful for classic psychedelic
sounds from the 60's.
◦ Tape Delay - A delay effect based on the classic Tape Delay hardware units, which
used magnetic tape as their recording and playback medium.
◦ Echo / Slapback – A slapback delay effect, which uses a mixing of the original and
delayed sounds to creates an effect similar to doubletracking..
◦ Chorus - A warm stereo chorus with a rich sound.
◦ Smart Unison - Creates the sound of several detuned stereo voices, with very low
CPU demands
◦ Ensemble - Simulates a large number of detuned voices playing at the same time.
Adds richness and movement to sounds. Very useful for vocal pad sounds.
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◦ Phaser - Creates a series of peaks and troughs in the frequency spectrum. The
position of the peaks and troughs is modulated so that they vary over time creating
a sweeping effect.
◦ Phaser Stereo - A stereo phaser with a vocalic sound.
◦ Flanger - Peaks and notches are produced in the resultant frequency spectrum
related to each other in a linear harmonic series. Creates a sweeping effect.
◦ Flanger Stereo - Peaks and notches are produced in the resultant frequency
spectrum related to each other in a linear harmonic series. Creates a sweeping
effect.
◦ Vibrato - Detunes the sound with an LFO.
◦ Vibrato stereo - Detunes the sound with an LFO, can be used instead of chorus if
a tight timing is needed.
◦ Tremolo - Modulates the amplitude with an LFO.
◦ Autopan – An automatic panning effect.
◦ Surround Pan – A surround panning effect.
◦ Rotary - Simulates a rotary speaker/Doppler effect made famous by the Hammond
organ.
◦ EQ High Cut – A High-band (High Pass) equalizer effect.
◦ EQ Low Cut - A Low-band (Low Pass) equalizer effect.
◦ EQ Param – A parametric 3-band equalizer.
◦ Saturate – A saturation effect.
◦ Soft Clip – Provides a soft clipping effect.
◦ Hard Clip – Provides a hard clipping effect.
◦ Rectify – A rectification distortion effect.
◦ Bitcrush - A lo-fi (low fidelity) digital audio effect.
◦ Warp – A warp distortion effect.
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◦ Waveshape – Waveshaper effect.
◦ Amp Sim - Simulates a guitar amplifier.
◦ Multiband Distortion – A multiband distortion effect.
◦ Degrader - Sample rate reduction effect.
◦ Multiband Degrader - A sample rate reduction effect that operates on multiple
separate bands.
◦ Noise – A noise effect with the options to add White, Pink noise, Crackle or Hum to
your signal.
◦ Compressor - Boosts the volume of lower volume notes, while capping the louder
ones, giving a more even level of volume.
◦ Surround Encode - Dolby Prologic II compatible surround encoder. It is also useful
to add a more spatial effect to your stereo recordings. If you encode to ‘Back’ the
channel will come from the rear speaker if you play your song on a surround
system. The sound remains fully stereo compatible.
◦ Trancegate - Adds a rhythmic volume gated pattern to the sound.
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EQ – Limiter Section

The EQ section gives a broad tone control over the output, the three controls gives a boost or
cut over the low, middle and high frequencies. The EQ consists of six knobs to allow total
control over the final output.
Tool – The tool menu offers several EQ preset options.

•

EQ controls
•

Low – Adjusts the lower frequencies. Set to the middle position it's function is bypassed.

•

Mid – Adjusts the middle frequencies. Set to the middle position it's function is bypassed.

•

High – Adjusts the higher frequencies. Set to the middle position it's function is bypassed.

•

Dbass – Equalizes non-linearities of the human ear, making the patch sound thicker
and louder, without raising the overall volume.

•

Freq. – Shifts the EQ Mid Frequency.

•

Q – Adjusts the EQ's bandwidth: number of frequencies that will be cut or boosted.
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Limiter
The limiter section applies gain reduction to attenuate (reduce) transients and dynamics, it
can be used to stop the signal from clipping or distorting.

Limiter controls
•

Thresh – Sets the point (Threshold) at which the automatic volume reduction is
applied.

•

Ratio – Ratio determines how much the volume is reduced versus how far above the
threshold the signal is.

•

Attack – Adjusts how quick the volume is reduced once the input exceeds the
threshold.

•

Release – Adjusts how long it should take before the volume returns (released) to its
original value when the input is no longer above the threshold.
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